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Get Maximum Value From Your Workday!  
 

Available Programs and Services for Customers 

 

 

Workday Pro 

This customer-focused accreditation program helps drive greater Workday 

competency and self-sufficiency for your organization. 

 

The Next Level 

A series of online demonstrations that show Workday in action and give you tips on 

deploying features. 

 

Adoption Kit 

This collection of templates and resources accelerates student training and your 

Workday rollout. It includes a combination of videos and job aids, as well as 

facilitation and marketing materials. All content can be tailored to your needs, or used 

as is. 

 

Learn Independent 

This learning experience combines videos, interactive exercises, quizzes, and tests 

into a comprehensive, online learning curriculum that students can complete at their 

own pace. Courses include: Business Process Fundamentals and Configurable 

Security Fundamentals. 

 

Enablement Workshops 

In-person training with hands-on configuration in your own sandbox tenant. 
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Learn Virtual 

Our Virtual Classroom offers the advantages of live instructors without the expense 

and time associated with travel. Students connect to our training environment and 

participate remotely, complete hands-on activities, and interact with instructors and 

other students. Courses include:  

  HCM Transactions 

 Payroll Transactions 

 Business Process Fundamentals 

 Configurable Security Fundamentals 

 

Office Hours 

One-hour appointments with Workday consultants to ask how-to questions or view 

tailored demos of features you already own. 

 

Learn On-Demand 

As a supplement to instructor-led offerings, this training provides immediate access to 

specific courses and includes short, topic-specific videos and job aids. 

 

Jumpstart Services 

A design-focused engagement preparing you for a successful deployment by 

delivering a detailed design guide and deployment approach. Service includes: 

Jumpstart Plus Package for Workday Executive HCM Dashboard. 

 

Premium Customer Success 

A designated Customer Success Manager partners with the project team during 

deployment to provide additional guidance and project oversight. During production, 

the CSM works with the customer to continuously drive business value from Workday. 

 

Learn In-Person 

This instructor-led, in-classroom training prepares students to meet their job 

requirements. It combines lectures, social learning, product demonstrations, and 

hands-on activities. Courses include: 

  HCM Fundamentals 

 Benefits Fundamentals 

 Compensation Fundamentals 

 Financials Fundamentals 

 Payroll Fundamentals 

 Procure-to-Pay Fundamentals 

 Recruiting Fundamentals 

 Workday Integration System Fundamentals 

 

Review and Recommend 

A detailed review of your Workday configuration and identification of new ways to 

optimize your Workday solution. Service includes: Review and Recommend for HCM 

Reporting and Analytics. 

 

Deployment Services 

Accelerated services to guide you with configuration and roll-out of new functionality. 
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WORKDAY INTEGRATION SYSTEM FUNDAMENTALS 

FOR WORKDAY 30 

DESCRIPTION 

This class introduces Workday users to tools and concepts needed to build and maintain 

Workday integration systems. We explore the technologies used to integrate with Workday and 

discuss the strengths and limitations of each. This class also introduces basic concepts in web 

services and XML and how Workday integrations leverage them. 

 

GOAL & OBJECTIVES 

This class is designed to prepare you to leverage the Workday integration architecture and 

associated integration technologies. 

 Define the Workday integration framework 

 Define core concepts needed to use Workday integration tools 

 Build, launch, and monitor Workday integration systems 

 Configure integration business processes and security 

 Transform and deliver integration output 

 Determine which tools to use in an integration scenario based on their strengths and 

limitations 

 

AGENDA 

 Workday Integration Architecture and Overview of Tools 

 Reporting as a Service (RaaS) 

o XML Overview 

o Integration IDs 

o Enterprise Interface Builder (EIB) 

 Workday Web Services (WWS) 

o Workday Public Web Services 

o Integration Cloud Connect 

 Business Process Framework 

o Delivery 

o Notifications 

o Document Transformation 

 Integration System Security 

 Workday Studio 

 Common Design Patterns 
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COURSE STRUCTURE 

You will use this course manual throughout the course. There are various interactive elements 

throughout this course, including: 

   

 

Activities You use your individual training tenant to perform activities in the 

Workday system. These activities reinforce concepts discussed in 

the demos and course manual. 

Most activities include “shortcuts”: pre-built reports and integrations 

for students to investigate key concepts without having to perform 

configuration tasks. 

Some activities include unguided Challenge Tasks meant for those 

students wishing to explore advanced concepts on their own. 

 

Optional 

Activities 

The instructor demonstrates concepts, configuration, and 

functionality within a Workday training environment. Students are 

welcome to work through the demo steps in their tenants as time 

permits. 
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CHAPTER 1 – INTRODUCTION TO WORKDAY 

OVERVIEW 

Workday’s suite of business services is hosted as a set of metadata and microservices that 

support a persistent, in-memory store of objects. All interaction with these objects is done via 

web services. 

 

OBJECTIVES 

By the end of this chapter, you will be able to: 

 Explain how the Integration Cloud Platform fits within the Workday architecture. 

 Compare SOAP and REST API functionality. 

 Define Workday Integration Systems and Services. 
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INTEGRATION ARCHITECTURE OVERVIEW 

All Workday customer data is stored as objects within a persistent, in-memory store. Originally, 

a suite of business services called the Object Management System (OMS) maintained the 

relationships and integrity of these objects. Over time, the OMS has evolved to become a set of 

microservices that scale based on transaction and reporting demand. The only way to access 

Workday object data is via web service requests. This is an important aspect of how Workday 

addresses issues such as security and performance. 

All communication with the Workday services is via HTTPS requests. Users generally access 

Workday through web browsers. The User Interface Server (UI Server) handles these requests, 

presenting HTML forms for user interaction, while communicating with the Workday platform 

using XML messages. Developers also connect via the UI Server to make use of the browser-

based tools, for example, when configuring Integration Systems or building integrations using 

Enterprise Interface Builder (EIB). 

Workday has application programming interfaces (APIs) that support both inbound and 

outbound requests for mobile applications and data-driven integrations that do not use the 

Workday UI. 

Inbound 

 Data is fed into Workday. 

 Incoming data is transformed 

into Workday Web Service 

(WWS) compliant format. 

 

 

Outbound 

 Data is provided by Workday. 

 Outgoing data may be 

transformed. 

 

 

 

 

Workday supports integration scheduling, data encryption, and secure transfer protocols, 

allowing for the regular synchronization of large volumes of customer data using file servers. 
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INTEGRATION CLOUD PLATFORM 

Workday's enterprise-class Integration Platform-as-a-Service allows all integrations to deploy to, 

and run in, the Workday Cloud without on premise middleware. Workday hosts these 

integrations, freeing you from the burden of managing and maintaining separate infrastructures. 

 

1 - Workday integration architecture 

There are three ways to access the web services to get and update data via an integration 

system to your Workday tenant. You can use the delivered configurable integrations (Cloud 

Connect), custom integration tools to create integration systems (EIB and Workday Studio), or 

your own existing middleware. 
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WEB SERVICES 

A web service is a method of communication between two electronic devices over the web. At 

its simplest, it is a client—typically, an application accessed on an internet browser operated by 

a person—and a server that houses a web service application. 

The application or system will send a request to the server so the end-point application, or web 

service, can process the request. The web service application will generate a response and 

send it back to the browser application via the server. 

 

There are standards and rules that need to be adhered to while writing these services. For 

example, if I offer a web service, I publish a document using Web Service Description 

Language (WSDL). Put very simply, it defines the rules of the service that I offer so you can 

build a client application to interact with it. 

Web Services: 

 Are application components. 

 Can be used by other applications. 

 Communicate using open protocols. 

 Are based on HTTP and XML. 

 Are self-contained and self-describing. 
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TWO TYPES OF WEB SERVICES: SOAP AND REST 

Simple Object Access Protocol (SOAP) web services allow for platform-independent 

information exchange using XML. 

Architectures that use SOAP must: 

 Expose a list of the operations that the web service offers. 

 Provide a description of each interface, including input and output message formats. 

o A web service specification is sometimes referred to as a contract. 

o WSDL is often used to describe the details of each operation. 

 Address any complex, nonfunctional requirements (availability, security, scalability, etc.) 

Representational State Transfer (REST) services allow sessionless data interchange using a 

simple request and response model. 

RESTful web services: 

 Do not typically require XML messages or WSDL documentation. 

o REST requests are simple URLs in many cases. 

o JavaScript Object Notation (JSON) is a common output format. 

 Are well suited for basic, ad-hoc integration scenarios, e.g., mobile applications and 

authentication. 
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WORKDAY WEB SERVICES 

Workday Web Services (WWS) provide a programmatic public API for our On-Demand 

Workday Business Management Services. WWS are implemented using industry standard web 

services technology which encompass WSDL, SOAP, REST and the WS-* standards. 

Delivering WWS on open standards means avoiding the traditional pitfalls of building tightly 

coupled and proprietary integrations that are brittle and difficult to change. 

 

SOAP API 

Workday Community provides API Documentation for our SOAP-based web services: 

https://community.workday.com/api. 

 

2 - Workday Web Services API Documentation Directory 

The SOAP interface is targeted for import and export of data needed for integration with 

enterprise business systems external to Workday. These integrations typically involve large 

quantities of data moving between systems, often scheduled and initiated automatically from 

one system to another. 

 

https://community.workday.com/api


Chapter 1 – Introduction to Workday 

Workday Integration System Fundamentals for Workday 30 

16  Confidential © 2018 Workday, Inc. 

REST API 

The Workday REST API is an addition to the Public APIs supported by Workday: 

https://community.workday.com/rest 

This RESTful interface supports enterprise web and mobile applications characterized by small, 

typically self-service transactions initiated by end users. This REST API exists alongside the 

current SOAP-based web services, but serves a different need. 

The REST API is designed to quickly return a small set of frequently used information for 

display or further action. Customers can integrate REST calls into an enterprise portal or mobile 

application, providing a subset of Workday functionality crafted for that specific audience. 

 

REPORTS AS A SERVICE (RAAS) 

Furthermore, Workday allows you to expose custom reports as web services. Web services-

enabled reports are accessible via both SOAP XML requests and REST URLs. 

https://community.workday.com/wws
https://community.workday.com/rest
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WORKDAY INTEGRATION SYSTEMS 

Workday includes several options to build integrations that interact with our Public Web 

Services and RaaS. In addition to the Integration Cloud Connect pre-built integrations, these 

tools give you a framework to build both inbound and outbound integrations based on your 

unique business needs. 

All integrations systems have certain key elements: 

Integration System: An external system defined in Workday. It provides both the security 

necessary for an external system to access Workday and a methodology to communicate data 

in a way that both Workday Web Services and the customer system understand. 

Data Source: The location of the data Workday will receive from an external source or will 

extract from Workday objects for output.  

Transformation (optional): Converts the data into something that Workday or the receiving 

external system can understand. Workday provides some transformations, but the users can 

create their own using XSLT. 

Transport Protocol: Where, or to what endpoint, the Integration System will send the 

integration’s outgoing message data. The transport protocol also defines the method of delivery. 

 

INTEGRATION SERVICES 

Integration services perform tasks required to run an integration system. Some services are 

unique to a given integration template; others (such as Integration Document Retrieval) are 

available to most integrations. Integration services are sometimes optional for a given 

integration system, and can be enabled and disabled as needed. 

List of Common Services: 

Service Definition 

Attributes Values that are required to configure the integration system. They are 

configurable constants that may need to be changed occasionally in 

Workday. 

Custom Object 

(Studio) 

Associates a Workday Custom Object with an alias defined in Workday 

Studio. Integrations built using Workday Studio use the Custom Object 

Service to access each Custom Object using this alias. 

Document 

Delivery 

Enables your integration to send output files to an external system over 

a range of different transports such as AS2, FTP, FTPS, and SFTP. 
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Service Definition 

Document 

Retrieval 

Enables your integration to import files from an external system over a 

range of different transports such as AS2, FTP, FTPS, and SFTP. 

Workday loads the integration file(s) into your W: Drive so that 

integrations can retrieve and process them. 

Field Attributes 

(Connectors) 

Enables you to configure the contents of an integration output file field 

by field. You can select which fields to include in the integration, specify 

whether the fields are required, and define maximum field length  

Field Overrides 

(Connectors) 

A flexible tool to customize your integration system. Use field overrides 

to map tenanted data to an external system and add custom values to 

integration output files. Field overrides use report fields or calculated 

fields to supply the values that are required by the external system. 

Integration Maps Used to map internal Workday values to their equivalent in external 

systems. For example, you might decide to map Workday cost center or 

gender codes into equivalent codes supported by the external system. 

Report Service 

(Studio) 

Associates a Workday custom report with an alias. Integrations built 

using Workday Studio use the Report Service to access the custom 

report using this alias. By using an alias, the integration can still locate 

the custom report even if the report's name or owner changes. 

Sequence 

Generator 

Generates a unique, sequenced file name each time it runs.  

Transaction Log Improves change detection performance by subscribing to events for 

particular transaction types or business process types. 

 

DATA SOURCES 

You may use the Reports as a Service (RaaS) or the Workday Public Web Service SOAP API 

as data sources for outbound integration systems. Inbound integrations use external files 

provided by a resource outside of Workday. Outbound data can be transformed, and inbound 

data typically requires transformation before updating Workday. 

 

TRANSFORMATIONS 

An integration transformation tells Workday how to convert data from an external system so that 

Workday can understand it, or how to convert Workday data so that the external system can 

interpret it. Workday supports three types of integration transformations:  

 Delivered transformations 

 Custom report transformations (EIB with RaaS only) 

 XSLT attachment transformations 
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TRANSPORT PROTOCOL TYPES 

A transport protocol tells Workday how to deliver data to or from an external system. Workday 

supports the following types of transport protocols to import or export data: 

Document Delivery: 

 AS2 

 Email 

 FTP 

 FTP/SSL 

 Google Cloud Storage 

 HTTP/SSL 

 SFTP 

 Workday Attachment 

Document Retrieval: 

 FTP 

 FTP/SSL 

 REST URL 

 SFTP 
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CHAPTER 2 – REPORTS AS A SERVICE 

OVERVIEW 

Workday enables you to build your own web services through our Report Writer / Custom 

Reports functionality. Web service-enabled reports may be used as data sources for custom 

integrations, such as those built with Enterprise Interface Builder (EIB) and Workday Studio. 

 

OBJECTIVES 

By the end of this chapter, you will be able to: 

 Configure a custom report as a web service. 

 Compare Workday XML and Simple XML data structure. 

 Locate integration IDs for objects in your tenant. 

 Build a simple integration using EIB and RaaS. 
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REPORTS AS A SERVICE (RAAS) 

When custom reports are web service-enabled, they become Reports as a Service (RaaS) and 

are exposed as both SOAP- and REST-based web services for integration scenarios. 

Only Advanced and Search reports can be enabled for web services. 

 

3 - Create Custom Report task with Enable As Web Service option selected 

 

Important: When you enable web services for a custom report, the maximum size of 

the response that Workday returns is 2 GB. 

 

NAMESPACE 

Namespaces define the scope of named elements and attributes in an XML document, avoiding 

conflicts where a single document might use the same tag name for multiple purposes. 

When you enable a custom report as a web service, Workday generates a default RaaS 

namespace for the report, using the following format: urn:com.workday.report/Report_Name 

(where Report_Name is the name of the report with underscores replacing spaces). 
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4 - Custom Report Advanced Web Services Options 

The RaaS namespace remains fixed even if the report owner changes due to transfers of 

ownership or if the report name changes. This prevents integrations that rely on the report's 

output from being unable to interpret the data. 

You can edit the namespace for a custom report. However, you should consider the following: 

 Workday does not verify that a changed RaaS namespace is unique. 

 If you have any integrations that use the report, you will have to update them to use the 

new RaaS namespace. 

Reports that are enabled as a web service must have XML aliases defined for all columns, 

prompts, and related business objects. 

 

5 - Custom Report Columns with Column Heading Override XML Aliases 
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WORKDAY REPORT XML 

Workday accepts REST-based report requests via URLs, enabling simple integration between 

Workday and external business services, such as payroll or benefits providers. 

To view the Workday XML, XSD, WSDL, and alternative report formats, navigate to the report in 

the tenant and use its Related Actions to view the Web Service URLs. If your report contains 

prompts, you will need to enter the values. 

 

6 - View URLs Related Action 
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Then click the Workday XML link to view the report in a browser window. 

 

7 - Workday XML link on the View URLs Web Service page 

 

Note: The first time you click the Workday XML link in a browser session, you will 

need to enter a user name/password. Make sure pop-ups are not disabled. 

 

8 - Basic authentication prompt 
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The Workday XML option outputs the literal, and somewhat advanced, XML code used 

internally within Workday. This option might be useful in cases where REST or SOAP is used to 

leverage Workday's sophisticated use of the XML language. 

 

9 - RaaS output as Workday XML 
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ACTIVITY 2.1 – CREATE A REPORT AS A SERVICE 

Business Case: You have been tasked with synchronizing position information with an 

external application. You will start by building a custom report to expose Workday position 

data as a web service. 

 Initially, the report will include a few simple report fields (no objects). 

 You will use a filter to limit the data to a range of dates. 

Shortcut: Use the pre-built report WDINST RW EIB Positions and skip to Task #2. 

TASK #1: CREATE A CUSTOM REPORT 

1. Sign in as Logan McNeil (lmcneil). 

2. Search for and select the Create Custom Report task. 

3. Enter the following information: 

Field Name Entry Value 

Report Name WICT RW Positions 

Report Type Advanced 

Data Source All Positions (second instance) 

Enable As Web Service Checked 

4. Click the OK button. 

5. On the Columns tab, click the Add button to add the following fields and XML 

Aliases: 

Field Column Heading Override XML Alias 

Position ID Position 

Position Text Title 

Annual Compensation / Pay in USD Pay 

Available for Hire Available 

Availability Date AvailabilityDt 
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10 - Columns tab with Column Heading Override XML Alias configured 

6. On the Filter tab, enter the following two filters: 

A.  

Field Name Entry Value 

Field Availability Date 

Operator greater than or equal to 

Comparison Type Prompt the user for the value 

Comparison Value Starting Prompt 

B.  

Field Name Entry Value 

Field Availability Date 

Operator less than or equal to 

Comparison Type Prompt the user for the value 

Comparison Value Ending Prompt 



Chapter 2 – Reports as a Service 

Workday Integration System Fundamentals for Workday 30 

28  Confidential © 2018 Workday, Inc. 

 

11 - Filter tab with Availability Date prompts configured 

7. On the Prompts tab, click the Populate undefined Prompt Defaults checkbox to add 

two rows under Prompt Defaults and enter the following: 

A.  

Field Name Entry Value 

Field Availability Date 

Prompt Qualifier Starting Prompt 

Label For Prompt XML Alias Start 

B.  

Field Name Entry Value 

Field Availability Date 

Prompt Qualifier Ending Prompt 

Label For Prompt XML Alias End 

 

12 - Prompts tab with Label for Prompt XML Alias configured 
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8. On the Advanced tab, verify the following: 

A. Enable As Web Service is checked. 

B. Web Service API Version is the highest available. 

C. Namespace includes the underscored version of your report name. 

9. Click OK to save your report. 

 

TASK #2: RUN REPORT AND VIEW WORKDAY XML 

1. Click the Run button to run your report, and enter the following at the prompts: 

A. Starting Availability Date: 01/01/2000 

B. Ending Availability Date: [today’s date] 

2. Confirm that there are 640 results. 

 

13 - Tenant report output 

3. Use the report’s Related Actions to select Web Service > View URLs. 

4. Enter the following dates in the prompts: 

A. Starting Hire Date: 01/01/2000 

B. Ending Hire Date: [today’s date] 

5. Click OK. 
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6. Select the REST Workday XML link. 

7. When prompted, enter lmcneil as the user and your tenant password. 

8. Review the report XML. 

 

14 - Workday XML output 
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XML OVERVIEW 

WHAT IS XML? 

 XML stands for Extensible Markup Language. 

 XML is a markup language, much like HTML. 

 XML was designed to carry data, not to display data. 

 XML tags are not predefined; each application must define its own tags. 

 XML is self-descriptive. 

XML does not do anything. XML was created to structure, store, and transport information. 

 

WHAT DOES XML LOOK LIKE? 

XML must be “well formed”. 

 

15 - Well-formed XML example 

XML has a single “root” element that contains all other elements. 

 

16 - Root “message” element 
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Elements are nested. 

 

17 - Nested "record" elements 

Elements contain either text or other elements. 

 

18 - "payload" element with text data 

Elements have begin and end tags. 

 

19 - Begin and end tags of "payload" element 
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Begin and end tags must be correctly nested. 

 

20 - Nested "record" elements correctly delimited with begin and end tags 

Elements can contain attributes. Attributes appear as name=”value” pairs within begin tags. 

 

21 - "record" elements with "ID" attributes 
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WORKDAY XML: RAAS ELEMENTS AND TAGS 

Workday XML from RaaS has a predictable structure based on the report definition. 

 

22 - RaaS Workday XML structure 

The wd:Report_Data root node contains list of wd:Report_Entry elements. (It also has an 

xmlns attribute that associates the wd prefix with the report namespace.) 

Each wd:Report_Entry contains list of other elements or "fields" as defined by the report. 

E.g., wd:Pay contains the contents of the Annual Compensation / Pay in USD field (77500). 
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SIMPLE TYPES VS. BUSINESS OBJECTS 

All Business Objects (BOs) have Workday IDs (WIDs). “Simple” data types display in black, 

whereas BOs typically display as blue, actionable links. BOs have Related Actions. 

 

23 - Custom report output with related business objects 

Fields that contain a BO have either a 1-to-1 or a 1-to-many relationship to the Business Object. 

 

24 - Custom report Columns tab with related business object fields 

Use the Group Column Headings section to provide XML Aliases for related business 

object data. 

 

25 - Group Column Headings configured with Group Column Heading XML Alias 
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The resulting Workday XML contains Integration IDs associated with the business object 

instance. Related business objects are nested within Group Column Heading XML Aliases. 

 

26 - RaaS Workday XML output including objects 

In this example, wd:Location contains a wd:Descriptor attribute with a value of Dallas. 
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ALTERNATE OUTPUT FORMATS 

Simple XML 

Workday XML may be too complex for many integration needs, such as quickly creating a 

refreshable report with Microsoft Excel. In such cases, the Simple XML option may be more 

appropriate. 

Simple XML is particularly useful for basic desktop integrations, in which a knowledgeable user 

wants to integrate with other reporting tools such as Microsoft Excel or Crystal Reports. With 

Simple XML, the complexity of Workday XML is distilled into basic XML elements that are 

simple to understand and can be processed by many desktop applications. 

Simple XML results in XML that is easier to read and understand than Workday XML. Here are 

a couple of key examples of how it is different: 

 Single-instance fields are changed to simple string-type elements. 

 Multi-instance fields are changed to simple string-type elements. 

 Multi-instance fields within the primary business object are changed to simple string-type 

elements, with a semi-colon separating each value. 

 Data fields that only contain dates (that is, they do not contain times) output dates only, 

with no times or offset from GMT. 

Workday XML is the default output of an integration unless an alternate output is selected or a 

custom transformation is applied. 

 

Other Output Formats 

CSV: Comma-Separated Values. This output option is likely to be used to import data into a 

spreadsheet as simply and quickly as possible. No knowledge of XML or schemas is required. 

RSS: Really Simple Syndication. It is an XML standard for publishing frequently updated 

content over the Internet. Common examples are news headlines and blog postings. 

GData: Google Data protocol. This option is useful for integrations with Google gadgets and 

other cases where it is desirable to allow programmatic access to this data format. 

JSON: JavaScript Object Notation. This lightweight format has become the de facto standard 

for data interchange with cloud-based REST APIs. 
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ACTIVITY 2.2 – ADD BUSINESS OBJECTS TO RAAS 

Business Case: You have been asked to include some position restriction information as well 

as worker details to your web service output. The data should also be organization-specific. 

 Modify the custom report to include object data, including fields from the Worker 

related business object (RBO). 

 Add a prompt to filter by Supervisory Organization. 

 Compare the output of Workday XML and Simple XML. 

Shortcut: Use the pre-built report WDINST RW EIB Positions with RBOs and skip to Task 

#2. 

TASK #1: MODIFY THE CUSTOM REPORT 

1. Sign in as Logan McNeil (lmcneil). 

2. Edit WICT RW Positions to include the following fields and XML aliases: 

Business Object Field Column Heading Override 

XML Alias 

Position and Job – All 

Staffing Models 

Hiring Restrictions – 

Location 

Restrictions-Location 

Position and Job – All 

Staffing Models 

Hiring Restrictions – 

Worker Type 

Restrictions-Type 

Worker Worker (first instance) Worker 

Worker Location Location 

Worker Worker Type Type 

3. Click the Add button in the Group Column Headings section and enter the following: 

A. Business Object: Worker 

B. Group Column Heading XML Alias: WorkerDetail 
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27 - Business object fields and Group Column Headings 

4. Click the Filter tab and add the following filter condition: 

Field Name Entry Value 

Field Supervisory Organization 

Operator In the selection list 

Comparison Type Prompt the user for the value 

Comparison Value Default Prompt 

 

28 - Filter with business object prompt 
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5. On the Prompts tab, click the Populate undefined Prompt Defaults checkbox to add 

the Supervisory Organization prompt. Accept the defaults. 

 

29 - Prompts tab with business object prompt configured 

 

TASK #2: RUN REPORT AND COMPARE SIMPLE XML TO WORKDAY XML 

1. Run the report with the following values: 

Field Name Entry Value 

Supervisory Organization IT HelpDesk Department 

Starting Availability Date 01/01/2000 

Ending Hire Date [Today’s Date] 

Note: All five new fields are actionable, although only three are hyperlinked. 
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30 - Custom report output with actionable objects 

2. Use the reports related actions to select Web Service > View URLs. 

3. When prompted, enter the following: 

Field Name Entry Value 

Supervisory Organization IT HelpDesk Department 

Starting Availability Date 01/01/2000 

Ending Hire Date [Today’s Date] 

4. On the View URLs Web Service page, select the Workday XML link. 

A. If prompted, enter your tenant username and password at the basic 

authentication prompt. 

B. Review the resulting XML. Pay particular attention to Position P-00043. 
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31 - Workday XML output including objects 

5. Return to the View URLs Web Service page and click Simple XML. 

6. Review the resulting XML. Again, pay close attention to Position P-00043. 
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32 - Simple XML output 

A. Compare the Simple XML to the Workday XML. What do you notice about the 

business objects? 

B. Compare the actual URLs of the Workday XML and the Simple XML. What is the 

difference between them? 

C. What is controlling the element names of the fields in the Workday XML? For 

example, if you wanted to change the value of <wd:AvailabilityDt> to <wd: 

AvailabilityDate>, where is that action performed? 

D. When viewing the Workday XML, the document contains a namespace of 

wd=”urn:com.workday.report/WICT_RW_Positions”. Where in the report 

definition is that defined? 
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INTEGRATION IDS 

Workday uses "Integration IDs" as an umbrella term for all of the various object identifiers that 

can be used for integrations. 

Many fields in Workday appear as lookups, presenting users with a limited list of values. Users 

can narrow down a list by typing in known codes (e.g., a worker’s employee ID) or partial search 

terms (e.g., the first few letters of an organization’s title). 

 

33 - Country prompt 

Each of these values is actually an object instance in Workday. Unlike users entering them 

through the Workday UI, background processes cannot generally access objects using their 

descriptions. Integration IDs provide a method to identify an object for retrieval or update. 

Integration ID types include Workday ID (WID), Reference ID and External ID. 

 

34 - Integration IDs for a Country instance 
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Workday ID (WID) 

A globally unique identifier that Workday automatically generates on all object data. Workday 

IDs consist of a 32-character, immutable string. E.g., bc33aa3152ec42d4995f4791a106ed09. 

WIDs are unique across all Workday environments, thus the same Workday object has different 

WIDs in your production, testing, and implementation tenants. Although the use of WIDs can 

prevent integrations from inadvertently running against the wrong environment, testing and 

migration of these integrations is more complex. 

 

Tip: The exception to the above is the sandbox environment, which is a regularly 

refreshed clone of your production environment. Because these two tenants share 

WIDs, it is recommended to test your integrations fully in your sandbox in case any of 

your solutions use WIDs for object references. 

Reference ID 

An optional, unique identifier that can be set externally or within Workday. Workday determines 

whether a business object can have one or more Reference ID types. All Reference IDs contain 

a "type" and a "value". 

 The "type" defines the attribute that holds the unique identifier (e.g. ISO_3166-

1_Alpha-3_Code). 

 The "value" is the identifier itself (e.g. USA). 

Reference IDs are only unique by type and value and can be shared between tenants. This 

allows you to build an integration in one environment and use the same object identifiers after 

moving to production. While Workday uses WIDs internally to represent data, Reference IDs are 

more useful for integration purposes, particularly when users need to manipulate them, such as 

when populating spreadsheet templates for inbound EIB integrations. 

External ID 

A two-part, unique identifier that is determined by an external system. They require an 

"Integration System" together with an identifier value. In prior versions, these IDs were referred 

to as "Integration IDs" but are now called "External IDs" for clarity. Since the introduction of 

Reference IDs, External IDs have become less common in integrations. 

External IDs consist of: 

 A “System ID”, which identifies an integration system in Workday. E.g., “SFDC” is a 

System ID for a tenanted integration system between Workday and Salesforce.com. 

 A “value”, which identifies a particular business object instance. E.g., W-001 is the 

external ID value for the Western region instance of the sales organization. 
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Reserved System ID 

A subtype of External ID that allow for backward compatibility with the original v1 and v2 

operations in the Workday API. The Reserved System IDs are internal system ID values that 

are needed for some web service operations that have not been updated to use Reference IDs. 

There are two types of Reserved System IDs still in use today: 

 WD-WID: Used to pass Workday IDs into a v1 or v2 operation. 

 WD-EMPLID: Used to pass Employee IDs or Contingent Worker IDs into a v1 or v2 

operation. 

For example, the Add Workday Account operation does not yet support Reference IDs. 

Integrations like the following EIB template need to use the WD-EMPLID System ID in order to 

refer to an existing worker when creating an account: 

 

35 - Spreadsheet template for Add Workday Account inbound EIB 
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FINDING INTEGRATION IDS 

Methods to locate the IDs needed for integrations consist of using related actions from objects 

in the user interface, and running the Integration ID or View Reference ID reports. 

Workday user interface 

One of the most effective ways to become familiar with the Workday object model and 

Integration IDs is through the Workday UI. 

To view IDs for a specific instance of a business object, click Related Actions > Integration 

IDs > View IDs. 

 

36 - Integration IDs > View IDs related action 
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37 - Integration IDs for a Location instance 

Integration IDs report 

This delivered report includes IDs for tenanted and non-tenanted data. Since Reference IDs are 

optional in Workday, and not all business objects support them, the Integration IDs report could 

contain instances of data that do not have reference ID values. 

To find all of the Integration IDs associated with a business object in Workday, search for the 

Integration IDs report and enter one or more Business Object types at the prompt. 

 

38 - Integration IDs report prompt with multiple business objects 
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39 - Integration IDs report displaying WIDs and Reference IDs 

 

Tip: Several worker-related business events prompt the user to enter a reason (e.g., 

hire, change job, termination). These event codes are classified into categories and 

subcategories. Categories make it easier to look up an event reason when entering 

data; the subcategory value is actually stored in the field. Use the Integration IDs 

report to generate a list of the subcategory reference IDs that you might need for an 

integration. 

 

40 - Integration IDs report for General Event Categories and Subcategories 
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View Reference ID report 

This delivered report shows all reference IDs for a single business object. It will display 

reference IDs specific to your tenanted data only. 

 

41 - View Reference IDs report displaying Reference IDs for a business object 
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ACTIVITY 2.3 – FIND INTEGRATION IDS 

Business Case: In order to become more familiar with Workday Integration IDs, you will find 

integration IDs for various business objects using different methods. 

 Use related actions to find integration IDs through the UI. 

 Run reports to review integration IDs for multiple instances of objects. 

 

TASK #1: USE THE UI TO VIEW REFERENCE IDS 

1. Sign in as Logan McNeil (lmcneil). 

2. Click Logan McNeil’s profile picture and click View Profile to access her Job Details 

(visible from the Summary or Job page). 

3. Use the related actions of the following objects to find the listed integration IDs: 

Object Integration ID Type Value 

Organization Organization_Reference_ID  

Position WID  

Time Type Position_Time_Type_ID  

Location Location_ID  

 

TASK #2: USE THE INTEGRATION IDS REPORT TO VIEW INTEGRATION IDS 

1. Search for and select the Integration IDs report to run it. 

2. Run the report for the following Business Objects to find the listed integration IDs: 

Business Object Instance Integration ID Type Value 

Language French WID  

Language Russian Language_ID  

Country United States WID  

Country Canada ISO_3166-1_Alpha-2_Code  

Employee Type Regular WID  
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Business Object Instance Integration ID Type Value 

Supervisory 

Organization 

IT HelpDesk 

Department 

WID  

Supervisory 

Organization 

Field Sales – North 

American Group 

Organization_Reference_ID  

General Event 

Subcategory 

Request 

Compensation 

Change > 

Adjustment > 

Performance 

General_Event_Subcategory_ID  

 

TASK #3: USE THE VIEW REFERENCE IDS REPORT TO VIEW REFERENCE IDS 

1. Search for and select the View Reference IDs report to run it. 

2. Run the report for the following Business Objects to find their Reference IDs: 

Business Object Instance Reference ID Type Value 

Absence Plan Floating Holiday Plan   

Compensation Plan General Salary Plan   
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SIMPLE INTEGRATIONS – EIB AND RAAS 

ENTERPRISE INTERFACE BUILDER 

The Enterprise Interface Builder (EIB) tool provides an easy-to-use graphical and guided 

interface to define inbound and outbound integrations with little to no programming. Both IT 

users and business experts can leverage EIB to address simple integration needs. 

 

42 - Enterprise Interface Builder (EIB) Outbound Design Pattern 

Because of its ease-of-use, EIB makes up 40-50% of all customer integrations. Of those, up to 

90% are outbound and use RaaS as the data source. Inbound EIB can make use of 

spreadsheet templates, allowing bulk imports of Excel-entered data into a Workday web service 

without any additional coding. 

EIB is quite limited, in that each integration only supports a single data source, one 

transformation (if needed), and one endpoint. Furthermore, EIB does not support any 

conditional logic, error handling, or configurable integration maps or attributes. As such, use EIB 

to solve integration problems of low data volume and complexity. 

 

Additional Training: The Simple Integrations course (3-day VILT) covers multiple 

inbound and outbound EIB use cases, including RaaS, WWS, custom 

transformation, and spreadsheet templates. 



Chapter 2 – Reports as a Service 

Workday Integration System Fundamentals for Workday 30 

54  Confidential © 2018 Workday, Inc. 

VIEWING AN INTEGRATION SYSTEM 

To search for an existing integration system, you can run the “View Integration System” report.  

 

43 - Locating Integration Systems using the View Integration System report 

You can also search for the name of the integration system directly. When searching, the 

default scope is “Common”. Since an integration will not be displayed using the Common scope, 

you will need to change it to “Integrations” or “All of Workday”. 

 

44 - Locating Integration Systems by search and category 

 

Tip: Use the intsys: prefix to force a search on integration systems by name. 
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LAUNCHING AN INTEGRATION SYSTEM 

From an integration system’s Related Actions, select Integration > Launch/Schedule. 

 

45 - Launching an Integration System by related action 

Launch / Schedule options include restricting processing by Organization and choosing a Run 

Frequency. 

In addition to launching an integration to run immediately, you can schedule integrations to run 

once in the future or on a recurring basis. You can also configure a scheduled process to be 

dependent on the completion status of another process, allowing for a dependent chain of 

integration and other events (e.g. reports). 
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46 - Launch / Schedule Integration task with Run Frequency options 

You must populate any required launch parameters, which could include prompts from a custom 

report data source. 

 

47 - Entering Integration Criteria 
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VIEW BACKGROUND PROCESS EVENT 

When an integration is set to Run Now, the View Background Process page is displayed 

immediately. Click the Refresh button until you see the Status change. If there are no errors, 

the Status will change to Completed once the integration event has finished processing. 

 

48 - View Background Process Page for an Integration Event 

 

INTEGRATION EVENT 

Launching an integration system creates a new integration event. The integration background 

process performs any required transformations and outputs the appropriate files or web service 

messages. 

You can access an event via the Process Monitor, however, the Integration Events report was 

specifically designed to monitor and review the results of integrations. 
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49 - Integration Events report search criteria 

 

Tip: Since each launch of an integration produces a new event, you should enter 

some criteria, such as a Sent After date and time, to limit the number of results. 

 

50 - Integration Events report results 

Clicking a link in the Integration Event column opens the View Background Process page for 

that launch. Each link in the Integration System column is a reference to the integration system 

itself, providing easy access to its View Integration System page and related actions. 
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ACTIVITY 2.4 – CREATE AND LAUNCH EIB 

Business Case: You will create your first integration using EIB to invoke your web service-

enabled report. 

 The EIB will leverage the WICT RW Positions custom report. 

 This first integration system will not require transformation nor deliver the output 

externally. 

Shortcut: Use the pre-built integration WDINST EIB Positions and skip to Task #2. (Note: 

The output for this integration is JSON instead of XML.) 

 

TASK #1: CREATE EIB 

1. Sign in as Logan McNeil (lmcneil). 

2. Search for and select the Create EIB task. 

A. Enter a Name of WICT EIB Positions. 

B. Select the Outbound option. 

C. Click the OK button. 

 

51 - Create EIB task 

3. Click Next to accept the default General Settings. 
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4. In the Data Source section, click the Edit button . 

A. In the Custom Report field, select the WICT RW Positions report. 

B. Click the Save button . 

C. Click Next to complete the Get Data step. 

 

52 - EIB Get Data step 

5. Click Next to skip the Transform step. 

6. In the Deliver section, click the Edit button. 

A. Enter a File Name of positions.xml. 

B. Click the Save button. 

C. Click Next to complete the Deliver step. 
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53 - EIB Deliver step 

7. Review the Summary and click OK. 
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54 - Viewing the EIB integration system 

 

TASK #2: LAUNCH EIB 

1. Search for and select the WICT EIB Positions integration system. 

2. From its Related Actions, select Integration > Launch/Schedule. 

3. Verify the Run Frequency is Run Now and click OK. 

4. Enter the following integration criteria: 
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Field Name Entry Value 

Supervisory Organization IT HelpDesk Department 

Starting Availability Date 01/01/2000 

Ending Hire Date [Today’s Date] 

 

55 - EIB Integration Criteria 

5. Click OK. 

6. On the View Background Process page, click Refresh until the Status is Completed. 

 

56 - Background Process details for Completed EIB integration event 
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7. On the Output Files tab, select the positions.xml file to view it. 

 

57 - Outbound EIB RaaS output 

 

CHALLENGE TASK: OUTPUT JSON INSTEAD OF WORKDAY XML 

1. Edit the EIB Data Source to select an Alternate Output Format of JSON. 

2. Change the File Name in the Deliver section to positions.txt to view it in a text editor. 

Hint: Use the EIB’s related action Enterprise Interface > Edit to return to the Summary. 
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CHAPTER 3 – WORKDAY WEB SERVICES 

OVERVIEW 

Workday's public web services (WWS) offer an open, standards-based API for programmatic 

access to our on-demand business management services. Integration Cloud Connect is a 

collection of templates that allows customers to take advantage of the power of WWS through 

configuration rather than coding. 

 

OBJECTIVES 

By the end of this chapter, you will be able to: 

 Locate documentation on Workday’s public web services. 

 Submit web service requests to Workday using a third-party application. 

 Explain Workday’s web service support policy. 

 Create a prebuilt integration using a Core Connector template. 



Chapter 3 – Workday Web Services 

Workday Integration System Fundamentals for Workday 30 

66  Confidential © 2018 Workday, Inc. 

PUBLIC WEB SERVICES – SOAP API 

Even without using Workday’s delivered and supported integration templates, you can 

incorporate Workday’s public web service (WWS) operations into your own applications. 

 

API DOCUMENTATION 

You might find it helpful to familiarize yourself with the details of the available WWS operations 

so that you understand their elements and validations: https://community.workday.com/api. 

Workday Web Services (WWS) API Documentation 

The Workday Community contains the latest documentation for our SOAP- and REST-based 

web services, with corresponding Web Service Description Language (WSDL) and XML 

Schema (XSD) files. 

 

58 - Workday Web Services (WWS) Directory 

https://community.workday.com/api
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Select a web service to view all of its available operations. 

 

59 - Staffing web service operations 

By selecting a specific operation, you can learn about its requirements, including the request 

and response messages, and their underlying elements. You can even download sample XML 

requests and responses. 

 

60 - Get Positions service operation details 
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WEB SERVICES DESCRIPTION LANGUAGE 

Web Services Description Language (WSDL) is an XML-based interface definition language that 

describes the functionality offered by a web service. Workday provides WSDL documents for all 

publicly available services. 

 

WSDL TERMINOLOGY 

Term Definition 

Service The available service and its Port 

Port The address or connection point to a web service 

Binding The binding style and transport for one or more Port Types 

Port Type 

(Interface) 

The input and output messages needed to perform an operation 

Operation A function or method being called via the service 

Types The valid data elements and structures for web service messaging 

 

VIEWING THE WSDL TO DETERMINE ENDPOINT 

Community documentation is not sufficient to integrate with a specific Workday tenant. You 

need to determine the actual endpoint for the WWS that you wish to access. 

For each delivered web service, you can view the WDSL specific to your tenant by running the 

Public Web Services report. (You can also retrieve the WSDL to access custom objects you 

have built in your tenant.) 
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61 - Public Web Services Report with View WSDL related action 

From the desired Web Service’s Related Actions, click Web Service > View WSDL. Scroll to 

the bottom of the WSDL and you will find the service endpoint in the location attribute within the 

<soapbind:address> element: 

 

62 - WSDL SOAP binding address location 

The API at this URL can accept SOAP-based web service requests from external applications 

into your Workday tenant. 

 

Reminder: You do not generally need to download a WSDL if you use Workday’s 

delivered technologies to integrate with external systems. Workday Studio, for 

example, includes a Schema Explorer that allows you to test and develop for WWS 

without having to run the Public Web Services report in your tenant. 
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WORKDAY XML: WORKDAY PUBLIC WEB SERVICES 

The XML response from a Workday Web Service (WWS) request is specific to each service 

operation and often more complex than the output from a RaaS request. 

 

63 - SOAP response example with namespaces highlighted 

SOAP acts as a wrapper around application-specific request and response data. A WWS 

request might include elements nested within both the SOAP Header and Body sections. 

XML namespaces provide a method to avoid element name conflicts between SOAP and 

Workday-specific XML tags. The namespace for Workday WWS is typically 

“urn:com.workday/bsvc”. 

Community provides full details of the SOAP XML elements for both the request and response 

messages of all publicly available operations. 
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WORKDAY COMMON HEADER 

The only SOAP Header element that Workday currently uses is a flag that sets whether or not 

you want Descriptor attributes in object data output. 

 

64 - Workday Common Header element of SOAP Header 

 

Note: Workday suppresses object descriptors if you omit 

Include_Reference_Descriptors_In_Response. 

 

GET REQUEST 

The scope of data returned from a “Get”-type WWS operation is determined by filters, criteria, 

and other parameters entered in the SOAP request. 

 

65 - API Documentation of a Get Request 

 

Important: Within the body of the SOAP request, the specific Workday API Version is 

included as an attribute on the root node of the service operation call. If omitted, the 

most current, supported API version for the operation will process the request. 
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REQUEST REFERENCES 

Use the <Request_References> section when there are specific instances of an object you want 

to retrieve. 

 

66 - API Documentation of the Request References section 

 

REQUEST CRITERIA 

The <Request_Criteria> element varies by service operation and allows you to limit the scope of 

data Workday will process. 

 

67 - API Documentation of the Request Criteria section 
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RESPONSE_FILTER 

The <Response_Filter> contains generic parameters that let you filter the data returned in the 

response. You can filter returned data by effective date, entry date-time, and page attributes. 

 

68 - API Documentation of the Response Filter section 

 

RESPONSE_GROUP 

The <Response_Group> contains a set of Boolean flags, allowing you to limit the types of data 

included for each record returned. If the request does not set any values for the response group, 

then the response returns a default set of elements. 

 

69 - API Documentation of the Response Group section 
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RESPONSE RESULTS 

The SOAP response returns a summary of the requested Reference, Criteria, Filter, and Group 

parameters, as well as the number of results included in the output. The <Response_Data> 

element contains the requested data itself. 

 

70 - Response Results section of a Get operation 

 

Note: The following demonstration uses SoapUI as a proxy for an external 

application accessing Workday via web services. You can use other web services-

aware clients and browser plugins to perform these same requests. If you have 

Workday Studio installed, you can investigate WWS using the Schema Explorer. 
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ACTIVITY 3.1 (OPTIONAL) – REVIEW SOAP 

REQUESTS AND RESPONSES USING SOAPUI 

Business Case: We are going to use SoapUI to test the Get Positions web service operation 

as a possible replacement of our custom RaaS. This operation is in the Staffing web service. 

 Other tools can also retrieve Workday WSDL and submit WWS requests. 

 The instructor will demonstrate this activity; it is optional for students. 

 

TASK #1: DETERMINE WWS ENDPOINT 

1. Sign in to your tenant as Logan McNeil (lmcneil). 

2. Search for and run the Public Web Services report. 

3. Review the list of available web services. 

4. Use the Staffing service’s related actions to select Web Service > View WSDL. 

5. In the new browser tab or window that opened, scroll to the bottom of the downloaded 

WSDL document. 

A. Locate the value of the soapbind:address location attribute. 

B. Select and copy (Ctrl-C) the address location (only select the value in quotes). 

 

71 - SOAP binding address location for Staffing WWS 

6. Close the new browser window or tab. 

 

TASK #2: CREATE WWS TEST PROJECT WITH SOAPUI 

1. Launch SoapUI using its desktop icon  or Start menu shortcut (under SmartBear). 

2. Create a new SoapUI project for your tests by selecting File > New SOAP Project. 
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3. Enter the details for your new project: 

Field Name Entry Value 

Project Name WICT Staffing 

Initial WSDL [service address location from previous task 

+ “?wsdl” suffix] 

Create Requests Unchecked 

 

72 - SoapUI New SOAP Project 

4. Click OK to retrieve the WSDL into the SoapUI project. 

 

TASK #3: CREATE REQUEST TO GET POSITIONS 

1. Right-click on the Get_Positions operation and select New Request. 

 

73 - SoapUI New Request command 

2. Enter WICT Get Positions as the name for your new request and click OK. 
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3. Modify the XML to create a test request with no criteria. 

<soapenv:Envelope 

xmlns:soapenv="http://schemas.xmlsoap.org/soap/envelope/" 

xmlns:bsvc="urn:com.workday/bsvc"> 

   <soapenv:Header> 

      <bsvc:Workday_Common_Header> 

         <!--Optional:--> 

         

<bsvc:Include_Reference_Descriptors_In_Response>true</bsvc:Include_Refe

rence_Descriptors_In_Response> 

      </bsvc:Workday_Common_Header> 

   </soapenv:Header> 

   <soapenv:Body> 

      <bsvc:Get_Positions_Request> 

      </bsvc:Get_Positions_Request> 

   </soapenv:Body> 

</soapenv:Envelope> 

4. In the Project Navigator, expand the Get Positions operation and select the WICT Get 

Positions request. 

5. Enter the following information into the Request Properties sheet: 

Property Value 

Username lmcneil@crossappgmsXX (where XX 

are the digits of your tenant) 

Password [your tenant password] 

WSS-Password Type PasswordText 
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74 - Get Positions Request Properties 

6. Click the Submit button  to send the request. 

 

75 - Get Positions Response with no criteria 

7. Review the response. 

A. How many positions (Total Results) did Workday find based on our request? 

B. How many total pages of results does this represent? 
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C. How many results were returned to SoapUI based on our request? 

D. Which page was returned? 

E. What types of positional data are included in the response? 

 

TASK #4: MODIFY REQUEST TO RETRIEVE 5 IT HELPDESK POSITIONS, 

INCLUDING QUALIFICATION DATA 

1. Create a new SOAP request by right-clicking on WICT Get Positions and selecting 

Clone Request. 

 

76 - SoapUI Clone Request 

2. Enter WICT Get IT HelpDesk Positions as the new request name and click OK. 

3. Add a Request Criteria section that limits the data to the IT HelpDesk organization 

(HINT: Search your tenant for org:it helpdesk to find its WID). 

4. Modify the XML to include a Response Filter that returns the first 5 results. 

5. Add a Response Group element that includes Position Definition Data and 

Qualifications. 
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Full request: 

<soapenv:Envelope xmlns:soapenv="http://schemas.xmlsoap.org/soap/envelope/" 

xmlns:bsvc="urn:com.workday/bsvc"> 

   <soapenv:Header> 

      <bsvc:Workday_Common_Header> 

         <!--Optional:--> 

         

<bsvc:Include_Reference_Descriptors_In_Response>true</bsvc:Include_Reference_D

escriptors_In_Response> 

      </bsvc:Workday_Common_Header> 

   </soapenv:Header> 

   <soapenv:Body> 

      <bsvc:Get_Positions_Request> 

        <bsvc:Request_Criteria> 

          <bsvc:Supervisory_Organization_Reference> 

             <bsvc:ID 

bsvc:type="WID">af6d7f10878340d186121b9d88ae1b5d</bsvc:ID> 

          </bsvc:Supervisory_Organization_Reference> 

        </bsvc:Request_Criteria> 

         <bsvc:Response_Filter> 

            <bsvc:Page>1</bsvc:Page> 

            <bsvc:Count>5</bsvc:Count> 

         </bsvc:Response_Filter> 

         <bsvc:Response_Group> 

            

<bsvc:Include_Position_Definition_Data>true</bsvc:Include_Position_Definition_

Data> 

            <bsvc:Include_Qualifications>true</bsvc:Include_Qualifications> 

         </bsvc:Response_Group> 

      </bsvc:Get_Positions_Request> 

   </soapenv:Body> 

</soapenv:Envelope> 
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6. Submit the request and review the results. 

 

77 - Get Positions Response with Request Criteria, Response Filter, and Response Group 

A. How many positions (Total Results) did Workday find based on our request? 

B. How many total pages of results does this represent? 

C. How many results were returned to SoapUI based on our request? 

D. What is a friendlier alternative to the WID to specify an organization? 

E. .What Response Groups are now included in the output? 

F. Are any Response Groups missing that were in the first response? 
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IMPORT VS. SUBMIT WEB SERVICES 

The Workday Import Web Service (IWS) pattern improves integration performance during large 

data loads by running a background process for each request that splits up large documents 

into smaller data sets. 

 

78 - Sample Import Web Services Request 

The Import Web Service returns a reference to a Workday Web Service Background Process 

(WSBP) instance, allowing you to monitor the import process activity. 

 

79 - Sample Response from an Import Web Service Operation Request 
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You can monitor an import directly by using the Get_Import_Process_Messages operation. 

The Process Monitor in your Workday tenant also provides detailed information for any errors 

or warnings generated during processing. 

 

80 - Reviewing Import Web Service Requests with the Process Monitor 

As well as improving integration performance, the IWS design pattern has the following benefits: 

 It improves availability of the Workday application for other users and systems during 

data loads. 

 It provides better visibility into data loading jobs. 
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WORKDAY WEB SERVICES API SUPPORT POLICY 

You can find the Workday Web Services (WWS) API Support Policy on Community: 

https://community.workday.com/articles/437. 

 

SUPPORT 

Workday recommends using the most recent WWS version for optimum performance and 

stability. We update prior versions of our WWS APIs to maintain backward-compatibility for all 

non-current versions of our WWS APIs that have not reached an end-of-life status., but they are 

not generally enhanced. 

Backward Compatibility 

Workday strives to make our WWS APIs completely backward compatible from release-to-

release. Our WWS APIs are backward compatible in that an application created to work with a 

given API version will continue to work with that same API version even as Workday introduces 

new API versions. Workday does not guarantee that an application will always work with all 

future API versions as certain object model changes and data representations are often 

required as we continue to enhance the API.  

Deprecation 

When a specific operation within our WWS API is to be no longer enhanced or updated (and 

has been replaced another operation), Workday will communicate the deprecation of an 

operation through our API Documentation within our Workday Developer Network at 

developer.workday.com. Deprecated operations will continue to work and be accepted until an 

end-of-life status is reached.  

End-of-Life 

When an API operation is to be removed and requests for that operation are no longer 

accepted, advance “End-of-Life” notice will be given at least 18 months before support for that 

API operation is ended through developer.workday.com. Workday will also directly notify 

customers using API operations planned for removal. 

https://community.workday.com/articles/437
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When a new Workday version is released, you should review the available release notes: 

https://community.workday.com/wws/notes. 

 

81 – WWS Update Release Notes 

 

https://community.workday.com/wws/notes
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API CHANGE LOG 

Use the API Change Log report to display the changes to a WWS operation from one version 

to another. You will find this useful if you are considering updating your custom integration to 

use a newer version of an operation. 

 

82 - API Change Log for the Get Positions Web Service Operation 
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PREBUILT INTEGRATIONS – WORKDAY CLOUD CONNECT 

Workday Integration Cloud Connect consists of a growing number of packaged integrations and 

connectors to complement solutions that are built, supported, and maintained by Workday: 

https://community.workday.com/workday/connector. 

 

83 - Workday Connector Catalog on Community 

The benefits of this approach to the customer are many, including access to a set of integrations 

that are: 

 Lower cost, lower risk, and faster to deploy without requiring any coding. 

 Fully supported by Workday and are certified and tested across updates and patches. 

 Treated like any other part of the product, with a published product roadmap. 

 

Because of the high level of support provided for connectors, these templates should be your 

first choice when building new integrations. 

https://community.workday.com/workday/connector
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CONNECTORS 

Workday provides two types of Connectors: 

 End-to-End (Packaged) Connectors support a specific, named third-party application 

or service. When an End-to-end Connector is deployed, the specific business functions 

between the two systems are configured with no additional coding required. 

 Connectors are prebuilt integrations that address the majority of the integration effort 

required to connect to third-party endpoints. 

All Connectors require some level of tenant configuration and testing. Each customer may have 

specific mapping requirements and different endpoint configurations. These differences in 

customer configurations can be accommodated with Workday's integration templates and 

mapping capabilities. 

 

INTEGRATION TEMPLATES 

With the exception of EIB, when you view an integration system in the tenant, the Integration 

Template will indicate which tool was used to build the integration system. 

 

84 - Integration Template for a Core Connector 
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An integration template is a collection of integration services that enables communication 

between Workday and an external system. Many of the delivered templates contain default 

values for attributes, as well as configurable prompts for attributes and maps to refine the 

integration for your needs. 

Outbound connectors have built-in change detection, allowing you to schedule integrations that 

only output the incremental data changes that take effect between launches. The Transaction 

Log Service further limits the scope of events to suit your needs. 

The Integration Template Catalog report provides the list of available integration templates in 

your tenant. Click the View Details button to see a summary of the services, attributes, and 

maps supported by a template. 

 

85 - Integration Template Catalog report 

 

Additional Training: The Core Connector and Document Transformation course (2-

day VILT) covers common inbound and outbound connector examples, as well as 

the use of Document Transformation to enhance output and to transform input files. 
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ACTIVITY 3.2 – CREATE AND LAUNCH A 

CONNECTOR 

Business Case: You will explore using a connector as a better supported and more feature-

rich alternative to EIB with RaaS, and as a more easily configured option to WWS requests. 

 The Core Connector: Positions template is based on the Get Positions operation, 

but allows for the selection of individual fields for output. 

 You will disable change detection when testing by choosing the Full Extract option. 

Shortcut: Use the pre-built integration WDINST CC Positions and skip to Task #3. 

 

TASK #1: CREATE INTEGRATION SYSTEM 

1. Sign in as Logan McNeil (lmcneil). 

2. Search for and select the Create Integration System task. 

A. Enter a System Name of WICT CC Positions. 

B. In the New using Template prompt, select Core Connector: Positions. 

C. Click the OK button. 

 

86 - Create Integration System using the Core Connector: Positions Template 



Chapter 3 – Workday Web Services 

Workday Integration System Fundamentals for Workday 30 

Confidential © 2018 Workday, Inc.   91 

3. On the Configure Integration Services page, select the optional Job Qualification Data 

Section Fields service and click OK. 

 

87 - Configure Integration Services with an optional Data Section Fields service enabled 

 

TASK #2: SELECT FIELDS 

1. Use WICT CC Positions’ related actions to select Integration System > Configure 

Integration Field Attributes. 

2. Select the Core Connector: Position Data Section Fields service to select the 

following fields for output (Position ID is required and already selected): 

A. Supervisory Organization 

B. Job Posting Title 

C. Available for Hire 

D. Availability Date 
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E. Location 

F. Worker Type 

G. Filled By Worker 

 

88 - Position Data Section Fields Included in Output 
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3. Select the Core Connector: Job Qualification Data Section Fields service to select 

the following fields for output (Position ID is required and already selected): 

A. Education Qualification 

B. Education Qualification / Education Degree 

C. Education Qualification / Education Field of Study 

 

89 - Job Qualification Data Section Fields Included in Output 

4. Click the OK button. (Do NOT click Done.) 

 

TASK #3: LAUNCH INTEGRATION 

1. If necessary, search for and select the WICT CC Positions integration system. 

2. Use the WICT CC Positions related actions to select Integration > Launch / Schedule. 

3. Accept the default Run Frequency of Run Now and click OK. 
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4. Enter the following Integration Criteria: 

Field Entry Value 

Supervisory Organization(s) IT HelpDesk Department 

Full Extract Selected 

5. Click OK and click Refresh on the View Background Process page until the Status is 

Completed. 

6. On the Output Files tab, select output.xml to download it. 

 

90 - Connector Integration Event Output Files 
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7. Review the results. 

 

91 - Core Connector: Positions output 

 

CHALLENGE TASK: REVIEW MESSAGES AUDIT 

1. Download the MessagesAudit_1.zip file from the Output Files tab of the event. 

2. Compare the xml files with the SOAP requests and responses in Activity 3.1. 
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CHAPTER 4 – INTEGRATION BUSINESS PROCESS 

OVERVIEW 

A business process in Workday is a set of tasks that people initiate, act upon, and complete in 

order to accomplish a desired business objective. Workday supports integration-specific 

business processes using the Integration Process Event business process type. 

OBJECTIVES 

By the end of this chapter, you will be able to: 

 Trigger an integration event from a step in a business process. 

 Configure an integration process to deliver files to an SFTP server. 

 Enable notifications for integration events. 

 Transform the output of a connector using Document Transformation. 
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WORKDAY BUSINESS PROCESSES 

A business process is the definition of tasks that need to be done in order for an event to occur, 

the order in which they must be completed, and who must do them. The business process 

definition specifies the security group responsible for each step in the process, notifies the 

workers in these groups, and gets feedback on when each step is complete so it can move on 

to the next step. Steps can also be conditional.  

 

92 - Example Hire business process with both user-driven and automated service steps 

Workday's default business processes are delivered definitions that can be customized to meet 

your needs. You also have the option of configuring context-specific business processes (e.g., 

by supervisory organization). 

 

93 - Search for a business process using the 'bp:' search prefix 

Hire Employee 

• Initiation 

• Review 

Propose 
Compensation 

• Approval 

Create Workday 
Account 

• Service 

Assign Pay 
Group 

• Approval 
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Note: While you can create different versions of the same business process for 

different organizations, Workday recommends having a single definition per business 

process type for ease of maintenance and troubleshooting. 

 

Once you select a business process, you can view its steps and other details. 

 

94 - Organization-specific Business Process Definition with configured Integration step 

Business processes support automated step types, such as Services and Reports. Integration 

steps can be run as specific user accounts to determine their access to data, and fields from the 

business event can be mapped dynamically to integration system launch parameters. 

 

Note: Step Order labels can be non-consecutive (e.g., a, b, f); however, they are 

ordered alphabetically. You should therefore only use letters for steps to avoid 

confusion (e.g., b11 is alphabetically before b2). The first step is always “a – 

Initiation” and cannot be changed. 
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ACTIVITY 4.1 (OPTIONAL) – TRIGGER AN 

INTEGRATION FROM THE HIRE BUSINESS 

PROCESS 

Business Case: The IT HelpDesk Department has a need to synchronize filled positions with 

an external directory immediately upon completion of a new hire. 

 WDINST RW Positions by Worker is already RaaS-enabled for this purpose. 

 The instructor will create a new EIB using that report and configure an Integration 

step on the Hire for IT HelpDesk Department business process to trigger it. 

 

TASK #1: CREATE A NEW EIB 

1. Sign in to your tenant as Logan McNeil (lmcneil). 

2. Search for and select the Create EIB task, and enter the following: 

Field Name Entry Value 

Name WICT EIB Position - BP 

Outbound Selected 

3. Click OK and enter the following Get Data information: 

Field Name Entry Value 

Custom Report WDINST RW EIB Position by Worker 

Alternate Output Format (under Details) JSON 
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95 - Get Data step with Alternate Output Format selected 

4. Click Next to save the Get Data step. 

5. Click Next to skip the Transform step. 
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6. Enter a File Name of position_filled.txt in the Deliver step. 

 

96 - Deliver step with File Name configured for text output 

7. Click Next to save the Deliver step and review the Summary. 

 

TASK #2: ADD INTEGRATION TO BUSINESS PROCESS 

1. Search for bp:hire and select the Hire for IT HelpDesk Department business process 

definition. 

2. Use its related actions to select Business Process > Edit Definition. 

3. Add a Step and enter the following: 

Field Name Entry Value 

Step c 

Type Integration 
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97 - Added Integration Step 

4. Click OK and review the error. 

 

98 - Integration Setup error 

 

99 - Configure Integration System button on Integration Step 
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5. Click Configure Integration System and select WICT EIB Position – BP in the 

Integration prompt. 

 

100 - Configure Integration Step with EIB selected 

6. Click OK and enter the following: 

Field Name Entry Value 

Run As User lmcneil / Logan McNeil 

Field Worker 

Value Type Determine Value at Runtime 

Value Worker (second in list) 

 

101 - Integration Step configured with Run As User defined and RaaS prompt mapped to event data 

7. Click OK to save the Integration Step configuration. 
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TASK #3: HIRE AN EMPLOYEE 

1. Sign in to your tenant (or start a proxy session) as Jack Taylor (jtaylor). 

2. Search for org: it help and select the IT HelpDesk Department. 

3. Click the Staffing tab. 

4. Use one of the Senior IT Analyst (Unfilled) positions’ related actions to select Hire > 

Hire Employee. 

5. Select Existing Pre-Hire, enter Dion Jackson, and click OK to proceed. 

 

102 - Hire Employee using an Existing Pre-Hire 

6. Enter the following hire information: 

Field Name Entry Value 

Hire Date [Today’s Date] 

Hire Reason New Hire > Fill Vacancy 
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103 – Completed Hire Initiation Step 

7. Click Submit to initiate the hire process. 
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104 - Submitted Initiation Step 

8. Click Open to proceed to the Propose Compensation Hire step. 

9. Click Submit to accept the defaults and complete the Propose Compensation action. 

 

105 - Completing the Propose Compensation action 
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TASK #4: VERIFY INTEGRATION LAUNCH 

1. Search for and run the Integration Events report. 

2. Confirm that WICT EIB Position - BP was launched. 

3. Select the integration event link in the report. 

4. Select the Output Files tab of the View Background Process page and select the 

position_filled.txt file. Verify that it contains Dion’s information in JSON format. 

 

106 - JSON output of new hire position data 

5. Search for Dion Jackson and select the All of Workday category. 

6. Click the Hire: Dion Jackson link to open the business process event. 

7. Click Process to review the entire event. 



Chapter 4 – Integration Business Process 

Workday Integration System Fundamentals for Workday 30 

108  Confidential © 2018 Workday, Inc. 

 

107 - Hire event process details including Integration steps 

8. Sign in to your tenant as Logan McNeil (lmcneil) (or stop proxy). 

 

CHALLENGE TASK: LAUNCH CONNECTOR WITH CHANGE DETECTION 

1. Search for and select the WICT CC Positions integration system. 

2. Launch the integration for the IT HelpDesk Department with Full Extract cleared. (Note 

the date-time field values.) 

3. Review the output.xml file. 
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INTEGRATION PROCESS EVENT 

Workday supports integration-specific business processes using the Integration Process 

Event business process type. This business process type allows you to: 

 Separate the execution of the integration itself from the act of retrieving or delivering 

files. Configuring the retrieval or delivery action separately allows you to add additional 

steps between these actions and the integration execution, or add multiple retrieval or 

delivery actions before or after the integration execution. 

 Chain together several integration systems, allowing a subsequent integration system to 

consume the integration file(s) produced by one or more, earlier integration systems.  

The Integration Process Event default definition is usually delivered with your tenant. The 

default Integration Process Event consists of two steps, Initiation and Service (Fire 

Integration). 

 

108 - Integration Process Event Default Definition 

Before you can create an Integration Process Event for a specific integration system, your 

tenant must have a default definition for the Integration Process Event business process. If this 
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default definition does not exist in your tenant, you will be unable to access the 

Launch/Schedule Integration task for any integration system in your tenant. You must also have 

created the integration system that will use the Integration Process Event business process. 

 

INTEGRATION PROCESS EVENT STEPS 

The Integration Process Event allows the following step types: 

 Initiation 

 Approval 

 To Do 

 Integration – This step triggers an additional integration process. This integration can 

be of any type, including EIB, Connector, or Workday Studio. 

 Service – The Integration Process Event supports three service types: 

o Document Delivery delivers integration files from outbound integration systems 

to external endpoints. 

o Document Retrieval imports integration files either from an external endpoint 

(such as an FTP server) or by running a custom report. 

o Fire Integration executes the integration system itself, to either generate an 

output file (for outbound integrations) or load data from a file into Workday (for 

inbound integrations). 

 

CONFIGURE THE INTEGRATION PROCESS EVENT 

To create an integration system-specific business process, select Business Process > Create, 

Copy, or Link Definition from its Related Actions. 

 

109 - Creating a custom Integration Process Event 
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TRANSPORT SERVICES 

Configure a business process to transfer integration files with an external location by configuring 

Document Delivery and Retrieval Service steps, which describe file selection, transport, and 

encryption options for the integration file(s). 

 

110 - Adding a Service Step 
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Delivery Service 

 

111 - Configuring Document Delivery 

In the Document(s) section, select the source of the document to be delivered. 

In the Document Filter(s) section, specify tags that Workday should filter on when selecting 

documents to deliver. Available tags are specific to the integration template. By default, the 

Document Delivery service transports any files labelled as Deliverable  

In the Delivery Settings section, set delivery attempts and whether to derive or reuse existing 

settings. 

In the Transport section, select a transport protocol and specify details about the endpoint. 
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MAINTAIN INTEGRATION PROCESS EVENTS 

Access the integration business process to correct or maintain Document Delivery or Retrieval 

steps. You can search for the definition using the bp: prefix and the name of the integration 

system, or use the actionable link on the Business Process Definitions section of the integration 

system itself. 

 

112 - Business Process Definitions section showing configured Integration Process Event(s) 

 

Note: Once a custom Integration Process Event exists for an integration system, only 

use the Business Process > Create, Copy, or Link Definition related action to 

create new, organization-specific versions of the process. 
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TEST TRANSPORT 

Use the Test Transport task to verify and troubleshoot the configured Delivery or Retrieval 

Service. When testing your integration system's configured Delivery transport, you can either 

use a 10KB test file, or select a file from a previous integration event. 

Use the integration system’s related actions to select Integration > Test Transport. Select a 

configured transport and then one of the Available Actions: 

 Connect – tests connectivity to the endpoint using the provided credentials. 

 List Files – tests read access to the server and existence of file(s) by pattern. 

 Deliver File – tests write access to the endpoint using a test file or repository document. 

 

113 - Test Transport of (S)FTP Configurations 

 

Note: The Connect action will attempt to create folders if the directory path is 

incomplete on the server. 
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VIEW RESULT AND VERIFY DELIVERY 

The Integration Events report lists each execution of an integration system separately from any 

transport services. As such, the integration event will not indicate whether the file delivery was 

successful—the integration is just one step in the overall business process. View the “Parent 

Event” to see the status of all of the steps defined in the business processes associated with 

that integration system. 

 

114 - Parent Event link on the View Background Process page 
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115 - Subsequent Processes section of the View Event page showing Document Delivery status 
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ACTIVITY 4.2 – CONFIGURE A DELIVERY SERVICE 

FOR AN INTEGRATION 

Business Case: You are ready to deliver Workday position data to an SFTP server that will 

serve as a staging area for your integration. You will create a business process for the WICT 

CC Positions system to add a Delivery Service step. 

 As all student files will be delivered to the same SFTP server, you will include your 

initials in the path to create your own folder. 

 Your instructor will provide SFTP connection details. 

Note: If you used the shortcut in Activity 3.2 instead of creating a new integration system, 

continue to use WDINST CC Positions instead of WICT CC Positions in this activity. 

 

TASK #1: CREATE BUSINESS PROCESS AND CONFIGURE DELIVERY SERVICE 

1. Sign in as Logan McNeil (lmcneil). 

2. Search for and select the WICT CC Positions integration system. 

3. Use the Related Actions to select Business Process > Create, Copy, or Link 

Definition. 

4. Click OK to accept the defaults and create a new business process definition with 

today’s date as the Effective Date. 

5. Click the Add button to add a new step and enter the following: 

Field Name Entry Value 

Order d 

Type Service 

Specify Document Delivery 

6. Click OK. 
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116 - Integration Process Event with Document Delivery Service Step 

7. Click the Configure Document Delivery button. 

8. Click OK to accept today as the Effective Date and enter the following: 

Field Name Entry Value 

Document(s) From this Integration Process 

Delivery Settings Define Transport Explicitly 

Transport Type SFTP 

SFTP Address [provided by instructor] 

Directory /home/[your initials] 

Authentication Method User Name / Password 

User Id [provided by instructor – NOT lmcneil] 

New Password / 

Verify Password 

[provided by instructor – NOT your 

tenant password] 
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117 - Configured SFTP Transport 

9. Click OK and Done. 
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TASK #2: TEST DELIVERY AND LAUNCH INTEGRATION 

1. Search for and select the WICT CC Positions integration system. 

2. Use the Related Actions to select Integration > Test Transport and verify connectivity 

to the SFTP server. 

 

118 - Test Transport related action 

3. Launch WICT CC Positions, using its Related Actions to select Integration > Launch 

Schedule. 

4. Click OK to accept the default Run Frequency and enter the following: 

Field Entry Value 

Supervisory Organization(s) IT HelpDesk Department 

Full Extract Selected 

5. There is no Refresh button on the View Event page, so click on the View Event or 

Overall Process links to refresh the page until processing is complete. 
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119 – Refresh the View Event page by using the top two links 

6. To view the output file, scroll to the bottom of the page to Reports and Other Output 

Files. 
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120 - Integration Process Reports and Other Output Files 

7. In the Initial Integration Event section, use the Related Actions of the WICT CC 

Positions integration system to select Integration > Test Transport. 

8. Select List Files and click OK to verify that your file was delivered to the SFTP server. 

 

121 - Test Transport with List Files option 

 

 



Chapter 4 – Integration Business Process 

Workday Integration System Fundamentals for Workday 30 

Confidential © 2018 Workday, Inc.   123 

INTEGRATION NOTIFICATIONS 

To help monitor integration events, you can create one or more notification messages to send to 

groups of people based on integration event status. You can configure notifications to send to a 

Workday Inbox, email address, or both. 

The default integration notification can include text and content from external fields, as well as a 

link to the integration process event. 

The maximum size of a Workday email notification is 20 MB. Workday does not process email 

notifications larger than 20 MB and does not display error messages in this situation. 

To configure a notification for an integration system, used its related actions to select 

Integration System > Configure Integration Notifications. 

 

122 - Configure Integration Notifications related action 

Integration notifications can be triggered based on launch, change of status (e.g., from Initiated 

to Processing), or custom conditions. 

Recipients can be Workday users and/or external email addresses. 
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123 – Integration Notification Triggers and Recipients 

You configure Message content (Subject and Body) by adding static text and dynamic field 

elements that Workday will assemble into a message when the notification is triggered. 

 

124 - Integration Notification Message Content 
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NOTIFICATION RESULTS 

Integration Notifications appear to Workday recipients along with other system notifications. 

Click your profile icon and select Notifications to review these messages. 

 

125 - Integration Notifications in the Workday tenant 

 

Note: The default email notification template for integrations includes a link to the 

integration event and any included documents. Users clicking a link need to sign in to 

Workday to view the event or document(s). While you can also attach documents 

produced in the event right to the email, this is not recommended for security 

reasons. 
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TRANSFORMATION 

A transformation is the process whereby data is converted from one system so that an external 

system can understand it, and vice versa. In Workday, business processes allow for the 

configuration of a transformation step independent of the transport and integration of data. 

 

WORKDAY TRANSFORMATION OPTIONS 

Workday supports three types of integration transformations:  

 Custom report transformations 

 Delivered transformations 

 XSLT attachment transformations 

Delivered Transformations 

Delivered transformations are provided by Workday, and include the alternate output formats of 

RaaS reports. Some delivered transformations are specific to spreadsheet uploads using EIB. If 

your integration data source is based on a spreadsheet import template generated in Workday, 

the transformation is linked to a template model. You can edit the template model to change the 

spreadsheet details and Workday applies your changes to the transformation during the upload. 

Custom Report Transformations 

Custom Report Transformations are custom transformations that you define in outbound EIBs 

that use RaaS as their data source. They enable you to include or exclude report fields, define 

output order, format individual reports, and add headers and footers to output files. 

 

Important: Custom Report Transformations cannot be migrated between Workday 

tenants. Expert users in production use them to rapidly produce non-XML output from 

RaaS-based EIBs that they build in production. 

XSLT Transformations 

XSLT attachment transformations are custom transformations that you create by using 

Extensible Stylesheet Language Transformation (XSLT). 
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EXTENSIBLE STYLESHEET LANGUAGE TRANSFORMATION (XSLT) 

There are times when Workday does not present output in the desired format for simple 

integration tasks. One example is uppercase and lowercase letters. Workday stores names in 

mixed-case, but another system might require the last name appear as all uppercase letters. 

Another example might be the Social Security Number (SSN). SSN is typically formatted as a 9-

digit numeric value (if unmasked). Another system could require that the data be passed, but 

only the last 4 digits. 

In this case, you could implement an Extensible Stylesheet Language Transformation (XSLT) 

with your integration system. XSL stands for Extensible Stylesheet Language, a style sheet 

language for XML documents. 

 Formatting: If Workday data comes out of the system and is not compatible with the 

external system, XSLT can be used to transform the data. Some common examples are 

date fields – many external systems require a different date format from Workday. XSLT 

can be used to reformat the data to suit the endpoint’s needs. 

 Conditional Logic: You might want to produce a different output format based on the 

value of a particular data element. An example might be a contingent worker vs. a full 

time employee. Using if/then logic, you can tailor the output to the type of worker the 

XSLT is attempting to transform. 

 Custom Output: You may have a need to convert the document structure to support a 

legacy system (e.g. fixed column format), a business-to-business standard (e.g. EDI), or 

a portal use case (e.g. HTML5). 

 

Note: Workday does not generate or validate your XSLT attachments. These 

attachments can be used in EIB, Studio, and Document Transformation. 

 

Example: Source XML 

When creating your stylesheets, you must use the XML document you want to change as your 

starting point. The original document is not changed; rather, a new document is created based 

on the content of an existing one. 

You must reference the namespace of the original XML document that you are transforming in 

your stylesheet. You must also reference all of the elements and attributes as they appear in the 

document you are transforming. Space and case count!  
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Below is the output of a Core Connector: Positions integration system. Notice the namespace of 

ps=”urn:com.workday/coreconnector/positions” and the xml element names (start/end tags). 

 

126 - Core Connector example XML output 
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Example: Standard XSLT 

The xml stylesheet below is an example of using standard XSLT to transform the sample xml 

output above. Make note of the declared namespace and the “XPath” syntax used to select 

values from the original xml document. 

 

127 - XSLT to transform Core Connector example XML output 



Chapter 4 – Integration Business Process 

Workday Integration System Fundamentals for Workday 30 

130  Confidential © 2018 Workday, Inc. 

Example: Result 

 

128 - Result of standard XSLT 
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ACTIVITY 4.3 – COMPARE WORKDAY OUTPUT TO 

XSLT 

Business Case: Transformations often fail because of mismatches between the source 

document and the transformation logic. You have been asked to review an XSLT stylesheet 

that is not transforming the XML output of your RaaS report as expected. 

 As a form of XML, XSLT files must also be well-formed. 

 XML is space and case-sensitive. 

 Find three errors in the XSLT document. 

 

Note: If you used the pre-built report WDINST RW EIB Positions with RBOs in Activity 2.2, 

use that in place of WICT RW Positions in this activity.. 

 

TASK #1: COMPARE REPORT OUTPUT TO XSLT 

1. Search for and select the report definition for WICT RW Positions. 

2. Open the XSLT stylesheet provided by the instructor in a text or XML editor. 

3. Review the XSLT file and compare to the report definition. Find four errors. 

 

129 - Sample RaaS Output 
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130 - Example XSLT 
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DOCUMENT TRANSFORMATION 

The Document Transformation integration system template is part of the Cloud Connect 

Catalog. Using this template, you can attach an XSLT file that contains Workday-specific 

transformation attributes to apply transformations and validations to an integration system's 

output documents. These attributes are referred to as Element Transformation and Validation 

(ETV) and XML to Text (XTT). ETV and XTT provide a number of different ways to transform 

and validate elements in an XML document. 

Document Transformation only applies a transformation to a source file. It does not retrieve 

data, nor can it update Workday. As such, these integration systems will always run in an 

Integration step as part of a larger integration business process. 

 

Note: XSLT transformations using ETV/XTT are available to integration systems built 

using the Document Transformation template and in Workday Studio assemblies. 

These stylesheets cannot be attached to an EIB integration system. 

ETV and XTT allow Workday-specific processing instructions to be included in an XSLT file's 

elements using attributes. After adding the XSLT file that generates XML with ETV and/or XTT 

attributes to a Document Transformation integration system, Workday applies transformations 

and validations to the integration system's output documents. ETV and XTT provide a number 

of different ways to transform and validate elements, but still require that the XML defined in the 

XSLT file be valid XML. 

There are two separate namespaces, one for ETV, which outputs XML, and a second for XTT, 

which outputs non-XML. Both steps provide similar features that include: 

 Validation 

 Number/date formatting 

 Data mapping 

 Truncation 

 Counting and summing of Values 

ETV and XTT need to be declared in the namespace of the XSLT. 

xmlns:xtt="urn:com.workday/xtt" 

xmlns:etv="urn:com.workday/etv" 

They may be used together in the same XSLT document, but best practice is to separate them 

into two transformation steps. 

 

Tip: Once you declare that you are using XML to Text (XTT), Workday automatically 

strips XML tags out of the final document, producing flat files without the need for 

complicated schemas. 
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EXAMPLE: DOCUMENT TRANSFORMATION – XTT 

Below is an example of an XSLT stylesheet that uses XTT to transform the original XML output 

about to a fixed length file. Notice the XTT attributes, including separator, startTag, severity, 

fixedLength, dateFormat, and required. 

 

131 - XSLT to transform Core Connector example XML output using XTT 

 

132 - Result of XSLT with XTT 
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Additionally, ETV/XTT enables us to introduce simple validations. For example, the Education 

Degree is marked as required. If a value is missing, it will display as a warning on the event. 

 

133 - ETV/XTT validation messages appear in the integration event 

 

Additional Training: Document Transformation’s primary purpose is to transform 

Connector data. The Core Connector and Document Transformation (2-day VILT) 

course details ETV and XTT options, and the steps to chain these systems together 

in a business process. 

 

SEQUENCE GENERATORS 

Integration systems support the use of the Integration Sequence Generator service to generate 

unique filenames. This is most useful when delivering output to servers via file transfer protocols 

(SFTP, FTP) where there is a risk of overwriting data. 

Document Transformation systems have a Sequence Generator service enabled as part of their 

template. Configure the service by using the related actions to select Integration System > 

Configure Integration Sequence Generators. 
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134 - Configured Sequence Generator Format 

The sequence number is incremented at each launch of the integration. You can also make use 

of date/time patterns to construct unique, dynamic filenames. 

 

135 - Unique output filename produced by sequence generator 
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ACTIVITY 4.4 – LAUNCH INTEGRATION WITH 

DOCUMENT TRANSFORMATION 

Business Case: Our external application needs position data to be in fixed columns in order to 

interpret it. You will apply a Document Transformation to convert the data into a readable 

format as well as perform some simple validation. 

 The WDINST DT Positions XTT Fixed integration system already contains the 

XSLT you need. 

 You will add an Integration step in the WICT CC Positions integration process 

event to transform the connector output before delivery. 

Shortcut: Use the pre-built integration WDINST CC Positions with DT instead of WICT CC 

Positions and complete Task #3 and Task #4 only. 

 

TASK #1: ADD INTEGRATION STEP TO INTEGRATION PROCESS EVENT 

1. Sign in as Logan McNeil (lmcneil) 

2. Search for bp:wict and use the related actions of the Integration Process Event for 

WICT CC Positions (TOP LEVEL) to select Business Process > Edit Definition. 
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136 - Edit Business Process Definition for the Integration Process Event 

3. Click OK to accept the default Effective Date. 

4. Add a new Step with the following details: 

Field Name Entry Value 

Order c 

Type Integration 

5. Click the Configure Integration System button and use the Integration prompt to 

select WDINST DT Positions XTT Fixed. 
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137 - Configure Integration Step with Document Transformation 

6. Click OK to proceed and OK again to accept the default request details. 

 

138 - Completed Integration Step configuration 

 

TASK #2: ADJUST DOCUMENT DELIVERY SERVICE STEP 

1. Search for bp:wict and select the Integration Process Event for WICT CC Positions 

(TOP LEVEL). 
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139 - Integration Process Event with Document Transformation and Document Delivery 

2. Click the Configure Document Delivery button and click OK to accept the default 

Effective Date. 

3. In the Document(s) section, select From Specific Integration Step(s) and use the 

prompt to select the newly configured Integration Step. 

 

140 - Delivering Documents From Specific Integration Step 
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4. Click OK and Done. 

TASK #3: LAUNCH INTEGRATION WITH TRANSFORMATION 

1. Search for and launch the WICT CC Positions integration using its related actions with 

the following Integration Criteria:  

Field Entry Value 

Supervisory Organization(s) IT HelpDesk Department 

Full Extract Selected 

2. Refresh the View Event page using the Overall Process link until the event is 

Successfully Completed. 

3. Scroll down to the Event Document(s) section and download the output.xml and 

Positions_FixedWidth_1.txt files to compare them. 

 

141 - Fixed Width XTT output 

 

TASK #4: REVIEW DOCUMENT TRANSFORMATION EVENT STATUS 

1. Scroll to the Subsequent Processes section and locate the Integration Process: 

WDINST DT Positions XTT Fixed link in the Subsequent Process section, or search for 

it in the Integration Events report. 
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142 - Subsequent Processes section with Sub Integration Event details 

2. Click the link under Number of Warnings to see the warning. 

 

143 - Document Transformation XTT Warning 

 

TASK #5: CONFIRM DELIVERY OF TRANSFORMED OUTPUT 

1. Scroll to the Integration System link (Initial Integration Event section) or search for 

WICT CC Positions, and use its related actions to select Integration > Test Transport. 

2. Use the List Files action to confirm the fixed width .txt file is on the SFTP server. 

Note: The output.xml file from previous activities will also appear in the results. 
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144 - Test Transport results with Fixed Width file. 
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CHAPTER 5 – SECURITY FOR INTEGRATIONS 

OVERVIEW 

Workday has separate security requirements to set up and launch integration systems based on 

the integration type. Before you can create, edit, or launch an integration system, you must be in 

a security group that has access to the Integration security domain and permission to access 

the underlying integration system or template. 

OBJECTIVES 

By the end of this chapter, you will be able to: 

 Identify the requirements to configure and launch integration systems. 

 Create an Integration System User to automate the execution of integration events. 

 Schedule an integration system. 



Chapter 5 – Security for Integrations 

Workday Integration System Fundamentals for Workday 30 

Confidential © 2018 Workday, Inc.   145 

INTEGRATION SYSTEM SECURITY 

Workday's security model for integrations is as follows: 

Access to systems and output: Workday provides several security domains that secure your 

users' access to integration templates and integration systems. These domains separate the 

permissions needed to configure an integration from the permissions needed to run an 

integration and view the integration's output documents. You can also segment integration 

templates and systems and then grant access separately for each segment. 

Access to Workday data: All access to Workday data is through web service operations and 

Reports-as-a-Service. 

Access to external endpoints: Workday provides encryption, decryption, and signature 

options using PGP. Workday provides encryption (for AS2), SFTP authentication, SAML logout, 

and web service authentication using X.509. 

 

SECURITY FOR ACCESS TO INTEGRATION TEMPLATES, SYSTEMS, AND EVENTS 

Workday has separate security requirements to set up and launch integration systems 

(including EIBs) based on the integration type. 

Security Domain Allows 

Integration Build  Create or edit an EIB. 

 Create or edit an integration system. 

 Deploy a Workday Studio integration. 

 View an integration system or EIB. 

Integration Configure  Configure an EIB. 

 Configure one or more integration services. 

Integration Debug  Debug a Workday Studio integration. 

Integration Event  Launch an integration. 

 Schedule an integration. 

 View resulting integration events, including integration 

output documents. 

Integration Process  View details of processes that are commonly executed as 

part of an integration. 
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Security Domain Allows 

Integration Reports  View integration reports, including reports for integration 

events, exception audits, messages, and integration IDs. 

Integration 

Subscriptions 
 Edit integration subscriptions. 

 View integration subscriptions. 

Integrations: EIBs  Set up EIB-specific options (e.g. template model, custom 

report transformation). 

 

 

Resource: Review the Workday Administrator Guide “Reference: Security Domains 

for User Access to EIBs and Integrations” for the specific security requirements to 

configure and launch different integration system types. 

 

ACCESS TO WORKDAY DATA 

All access to Workday data is through web service operations and Reports-as-a-Service; these 

web service operations, report data sources, class report fields, and custom reports are secured 

to various security domains. For custom integrations, your developer must provide a list of the 

web service tasks and/or reports used by the integration. 

The Public Web Services report provides easy access to the permissions granted for web 

service operations: 

 

145 - Viewing Web Service Operations Security Groups from the Public Web Services report 

 

Resource: For delivered integrations, the complete list of connectors and their 

security requirements is available in the Workday Administrator Guide “Reference: 

Security Domains for Integration System Data Access”. 
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INTEGRATION SYSTEM USER 

Integrations systems require either a Workday user account or an Integration System User 

(ISU) account for authentication and access to web service tasks. While user accounts are 

useful for testing, and organization-specific data and business process requirements, you 

should adopt ISUs for the majority of your integrations. If you secure an integration with an ISU, 

changes to Workday user accounts won't affect normal processing of your integration. 

You give ISUs access to data by making them members of Integration System Security Groups. 

In order for inbound integrations to work correctly, these security group(s) must have Put and/or 

Get access to the domains that contain the web service operations that interact with the 

necessary data. 

 

INTEGRATION SYSTEM USER 

Access the Create Integration System User task and enter a User Name and New Password. 

An ISU represents a system, not a person. It is not intended that this user will launch the 

integration system from the tenant UI. As such, unless the ISU is for external access to 

Workday web services, the password should be complex and does not need to be memorable. 

 

146 - Creating an Integration System User 
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Security Note: A user with Get or Put access to a domain also has View and Modify 

access to reports and tasks in that domain. The Do Not Allow UI Sessions setting 

prevents this user from being able to log in to the tenant to perform UI tasks. 

 

INTEGRATION SYSTEM SECURITY GROUP 

Access the Create Security Group task and create an Integration System Security Group 

(Unconstrained). (Unconstrained security groups are not limited by organization.) 

 

147 - Creating an Integration System Security Group 

Once the group is created, you may add integration users. 

 

148 - Adding an ISU to an Integration System Security Group 
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Security Note: Although security groups are reusable, Workday recommends having 

a single ISU per integration system security group. This mitigates “privilege creep”, 

the tendency to accumulate permissions above what each individual in the group 

needs. 

 

SECURITY POLICIES 

Data access in Workday is organized by functional area (e.g., Resource Management). Each 

functional area includes Domain security policies that give access to UI tasks and fields (e.g., 

business asset report fields), and Business Process security policies that control many data 

entry transactions (e.g., Create Expense Report). 

 

Tip: Use the Domain Security Policies for Functional Area and Business Process 

Security Policies for Functional Area reports to review and configure the permissions 

of each domain or business process in a Workday application. 

You must first determine which web service tasks your integration system needs to access. 

Once you have identified the domains and/or business processes for those operations, assign 

the integration system security group to the appropriate security policies. 

 

Security Note: Security policy updates do not take effect immediately and are not 

effective dated. You must activate any pending policy changes at the moment when 

you want them to take effect. 

 

Maintaining Security Policies 

For each web service operation required by your integration system, access the View Security 

for Securable Item report and enter the web service task name, then note the security domain or 

business process security policy to which the operation is secured. 
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149 - View Security for Securable Item report 

Modify the security policy identified using the Related Actions of the policy or domain to include 

your integration system security group. 

 

150 - Editing the Permissions of a Domain Security Policy 
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151 - Adding a Security Group to a Domain’s Integration Permissions 

Next, run the Activate Pending Security Policy Changes task. 

 

152 - Confirming the Activation of Pending Security Policy Changes 
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Run the View Security for Securable Item report to confirm that your Integration Security Group 

is now a Permitted Security Group for that web service operation. 

 

153 - Domain Security Permitted Security Groups with Integration System Security Group included 

 

Editing Integration System Workday Account 

Add the ISU to the integration system by using its Related Actions to select Workday Account 

> Edit. 

 

154 - Editing the Workday Account of an Integration System 
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155 - Assigning the ISU as the Workday Account for Integration System 

 

Important: Once an ISU has been assigned as a Workday Account, it is no longer 

available for other integration systems. 

 

 

Tip: Customers can leverage the Maintain Permissions for Security Group task to 

assign domain security policies to security groups in bulk. This can be useful when 

you have a known list of domains, such as those provided for integration system 

templates in the Workday Administration Guide. 

 

156 - Maintaining Integration Permissions for Security Group 
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ACTIVITY 5.1 – CREATE AN INTEGRATION SYSTEM 

USER 

Business Case: You now need to synchronize positions on a regular schedule. You will create 

a new integration system user and unconstrained integration security group, update (and 

activate) the appropriate security policies, and assign the ISU to your connector. 

 Core Connector: Positions only needs access to the Worker Data: All Positions 

domain if you are not including job information in the output. 

Note: If you used the shortcut in Activity 4.4, continue to use “WDINST CC Positions with DT” 

instead of “WICT CC Positions” in this activity. 

 

TASK #1: CREATE INTEGRATION SYSTEM USER AND EDIT PERMISSIONS 

1. Sign in as Logan McNeil (lmcneil). 

2. Search for and select the Create Integration System User task and enter the following: 

Field Name Entry Value 

User Name CC Positions ISU 

New Password /  

New Password Verify 

P@ssw0rd 

3. Click OK and Done. 

4. Search for and select the Create Security Group task and enter the following: 

Field Name Entry Value 

Type of Tenanted Security 

Group 

Integration System Security Group 

(Unconstrained) 

Name CC Positions ISSG 

A. Click OK to continue. 

B. Select the CC Positions ISU account for Integration System Users. 

C. Click OK and Done. 

5. Run the View Security for Securable Item report for the Domain Item of Get Positions 

(Web Service) (Web Service Task). 
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6. Use the Related Actions of the Worker Data: All Positions security policy to select 

Domain Security Policy > Edit Permissions. 

A. Under Integration Permissions, use the prompt on the existing Get/Put record to 

select your CC Positions ISSG security group (do not add another row). 

B. Click OK and Done. 

7. Search for and select the Activate Pending Security Policy Changes task. 

A. Enter a Comment and click OK. 

B. Select the Confirm check box and click OK. 

8. Run the View Security for Securable Item report for the Domain Item of Get Positions 

(Web Service) (Web Service Task) to confirm your new security group was added. 

 

TASK #2: EDIT INTEGRATION SYSTEM WORKDAY ACCOUNT 

1. Search for and select the WICT CC Positions integration system. 

2. Use the Related Actions to select Workday Account > Edit. 

A. Select CC Positions ISU for the Workday Account. 

B. Click OK to save the Workday Account. 

C. Click OK to accept the default account preferences. 

 

157 - View Integration System with Workday Account 
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TASK #3: SCHEDULE INTEGRATION 

1. Use the WICT CC Positions’ Related Actions to select Integration > Launch/Schedule. 

2. For Run Frequency, select Hourly Recurrence and click OK. 

3. Accept the default Integration Criteria, select Schedule and enter the following: 

Field Name Entry Value 

Recurrence Interval Every 1 Hour (default) 

Start Time [Next possible 15-minute interval] 

Start Date [Today’s date] 

End Date [Tomorrow’s date] 
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158 - Hourly Recurrence Schedule 

4. Click OK. 

5. Wait until after your runtime and view the Integration Events report. 

TIP: The Scheduled Future Processes report includes a Refresh button. 

 

159 - Scheduled Future Process report filtered by Process 
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6. View the Integration Details of the integration event to confirm that it Ran As the ISU. 

 

160 - Integration Event for a scheduled integration 
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CHAPTER 6 – WORKDAY STUDIO 

OVERVIEW 

Workday Studio is a powerful, Eclipse-based development tool enabling customers and partners 

to build sophisticated and highly customizable integrations to and from Workday. 

OBJECTIVES 

By the end of this chapter, you will be able to: 

 Identify the integration requirements that are best solved with Workday Studio. 

 Configure sequence generator, maps, and attribute services for a deployed Workday 

Studio collection. 

 Launch and monitor a Studio integration system. 
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COMPLEX INTEGRATIONS – WORKDAY STUDIO PLATFORM 

Studio is a module build on top of the open-source Eclipse IDE (Integrated Development 

Environment) that helps developers design and build integrations. With this development tool, 

you create assemblies of reusable components that include transport, routing, configuration, 

and mediation steps. These assemblies form the basis of your integration. 

 

161 - Example Workday Studio Assembly 

Studio assemblies provide much tighter control over the flow of your integration, allowing for 

conditional branching and iteration, flexible exception handling and logging, and highly scalable 

processing of multiple data sources and endpoints. As an Eclipse module, Studio also supports 

custom Java. 

 

Resource: Visit the Workday Studio Community site to learn more about the platform 

and to download and install Studio: https://community.workday.com/studio.  

 

https://community.workday.com/studio
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WORKDAY STUDIO DEVELOPMENT 

Studio integrations are developed in distinct phases: 

 Design: Developers build assemblies in the Studio IDE installed on their workstations. 

 Deploy: Studio users with Integration Build permissions deploy those assembly projects 

as archived collections into the Workday tenant. 

 Configure: Integration administrators then use the Workday UI to configure any services 

needed by the Studio integration system, such as integration maps and transports. 

 Launch and Monitor: Once configured, these integration systems are ready to be 

tested and eventually scheduled in production. 

 

 

162 - Deployed Studio Integration System with configurable services 

 

Note: Although developers can test their assemblies by launching and monitoring 

their progress in Studio itself, the integrations actually run on an Enterprise Service 

Bus (ESB) in the Workday Cloud. You cannot test a Studio integration without tenant 

access. 

 

 

Additional Training: The Introduction to Workday Studio (2-day VILT) course 

provides an overview of Studio capabilities and introduces key concepts in managing 

and deploying Workday projects, and in understanding integration message flow. 

Advanced Workday Studio (3-day VILT) covers more detailed programmatic 

concepts, including routing, scalability, error handling, and collections. 
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CONSOLIDATED REPORT AND LOGS 

Integration events include a set of logs used for troubleshooting integrations. These include the 

launch request, server console log, and a performance profile log in CSV format. The 

consolidated report summarizes all of these in an XML format. It is available for EIB and some 

Connectors, but is most useful for troubleshooting Studio integrations. 

 

163 – Consolidated Report and Logs section of the View Background Process report 

 

VIEW CONSOLIDATED REPORT AND LOGS 

Click View Consolidated Report and Logs to see the overall event status and performance. 

Use the table to review detailed messages by component (item view) or a grid of components 

with status and processing times (tabular view). 
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164 - View Consolidated Report and Logs in tabular format 

 

VIEW PERFORMANCE LOG 

Click View Performance Log to review the more detailed profile information from the 

consolidated report. This report allows you to identify components that run poorly or have 

excessive memory usage. 

 

165 - View Performance Log 
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ACTIVITY 6.1 – LAUNCH WORKDAY STUDIO 

INTEGRATION 

Business Case: Your integration requirements have moved beyond the capabilities of 

delivered connectors, and you have engaged a resource to build a Workday Studio 

integration. You are now responsible for administering this integration system. 

 The WDINST_Positions_by_Org integration has already been deployed to your 

tenant. 

 You will review the configured sequence generators, integration maps, and 

attributes before testing. 

 

TASK #1: REVIEW INTEGRATION SERVICES CONFIGURATION 

1. Sign in as Logan McNeil (lmcneil). 

2. Search for and select the WDINST_Positions_by_Org integration system. 

3. Review the Custom Integration Services and make note of any Integration Attributes, 

Integration Maps, and Launch Parameters. 
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166 - Custom Integration Services 

4. Answer the following: 

A. What is the value of the Testing Mode attribute? 

B. What is the name of the Integration Map? What values are being mapped? 

C. What is the Launch Parameter? Is it Required? 

5. Use the related actions to select Integration System > Configure Integration Sequence 

Generators. 

6. Answer the following: 

A. How many Integration Sequencers have been configured? 

B. What are their Format/Syntax values? 
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TASK #2: LAUNCH A STUDIO INTEGRATION 

1. Launch the integration using its related actions to select Integration > Launch/Schedule. 

2. Click OK to Run Now. 

3. Select IT HelpDesk Department for Supervisory Organization and click OK. 

4. Refresh the Integration Event until processing is complete. 

A. What is the Status? 

B. Are there any Error or Warning messages? 

C. Which tab shows the launch parameter value? 

D. What files were output? 

E. Are any of the files Deliverable? 

 

167 - Studio Integration Event Messages 
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5. Download and view the output files. 

A. How are the files different? 

B. Where do you see the value of the Integration Attribute? 

 

CHALLENGE TASK #1: DISABLE TESTING MODE 

1. Use the Configure Integration Attributes related action to clear Testing Mode. 

2. Relaunch the integration and compare the results. 

 

CHALLENGE TASK #2: DELIVER OUTPUT 

1. Create a custom integration process event to add a Delivery Service step. 

2. Configure the Delivery to send the final output (only) to your SFTP folder using the same 

credentials as provided for WICT CC Positions. 

 

CHALLENGE TASK #3: SCHEDULE INTEGRATION 

1. Create an ISU and give it the appropriate permissions to launch 

WDINST_Positions_by_Org. 

 Hint: The only operation used by this assembly is Get Positions. 

2. Assign the ISU as the Studio Workday Account and schedule the integration to run with 

a daily recurrence. 
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CHAPTER 7 – COMMON DESIGN PATTERNS 

OVERVIEW 

Workday provides several types of integration tools that can address a wide range of data 

interchange problems. Often, a solution may require a combination of integration systems to 

fulfill a requirement. 

OBJECTIVES 

By the end of this chapter, you will be able to: 

 Explain Workday’s recommendations for inbound and outbound integrations. 

 Compare the strengths and limitations of the different integration tools. 

 Determine the appropriate design pattern(s) for common use cases. 
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RECOMMENDATIONS 

FULL FILE RECOMMENDATIONS 

Use a full data extract when your integration is not dependent on changes since the last run. 

 

 

CHANGE FILE RECOMMENDATIONS 

Some Workday tools are better than others at detecting changes between integration events. 

 

 

INBOUND RECOMMENDATIONS 

 

Connector 

• Use when available 

• Performance-tested 

• Use Document 
Transformation or 
Studio to enrich 
output 

EIB 

• Low complexity 

• Low volume 

Studio 

• Allows complex, 
conditional logic 

• Scales to large data 
sources (paging) 

Connector 

•Use when available 

•Built-in Change Detection 

•Transaction Log Service 

•Performance-tested 

•Use Document 
Transformation or Studio 
to enrich output 

Studio 

•Supports Transaction Log 

•Allows complex logic 

•Scales to large data 
sources (paging) 

Avoid EIB 

•Requires complex 
calculated fields 

•Computing differences 
with calc fields is costly 

•Would need to maintain 
multiple calc fields 

Connector 

•Use when available 

•Performance-tested 

•Generally supports XML 
and CSV schemas 
without transformation 

•Can use DT to transform 
XML 

EIB 

•Supports spreadsheet 
templates for user loads 

•Supports Import Web 
Services 

•Scheduling possible, but 
not recommended 

Studio 

•Supports Import Web 
Services 

•Scales to large data 
sources (splitting, 
document iteration) 

•Can transform multiple 
formats 
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DESIGN PATTERNS 

Pattern Benefits/Limitations 

Outbound Connector 

 

 Delivered 

 Built-in change detection 

 Works for Full File and Changed File 

 Can filter by the Transaction Log 

 Reasonable if only a restricted 

number of field overrides (< 30) 

 Avoid overrides that use calculated 

field prompts 

 Out of the box support for the 

required output format 

 Delivery service supports the file 

delivery requirements 

Outbound Connector with Document 

Transformation 

 

 Document Transformation specifically 

designed to work with Connectors 

 ETV and XTT availability 

 Document Transformation can include 

integration maps and attributes 

 Reasonable if only a restricted to 3 or 

fewer transformations (otherwise, use 

Studio) 

 Runs in 2 hours or less 

 Delivery service supports the file 

delivery requirements 

Outbound Connector with Studio 

 

 Connector exists and outputs most of 

the required data fields 

 Use Studio to enrich output of 

Workday Connector 

 Reasonable if multiple and complex 

XSLT stylesheets are required 

(ETV/XTT available as of WD28) 

 Integration can complete in less than 

2 hours 
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Pattern Benefits/Limitations 

Outbound EIB 

 

 Fully Custom 

 Low complexity; no error handling 

 No change detection 

 No integration maps or attributes 

 Reasonable if all data can be 

retrieved in a single data source 

 No paging logic (Soap API) 

 One transformation only (ETV/XTT 

not supported) 

 One destination endpoint 

 2 hour XSLT limit 

Outbound Workday Studio 

 

 Fully Custom 

 Integration maps, attributes, and 

launch parameters 

 Split large input files 

 Aggregate data 

 More than one data source (multiple 

calls to Workday and/or externally) 

 Multiple output files 

 Multiple transformations (ETV/XTT 

supported as of WD28) 

 Support for non-XML schemas 

 Conditional logic and complex error 

handling capabilities 

Inbound Connector 

 

 Connector interface includes all the 

data elements that need to be 

imported into Workday 

 Supports XML and CSV schemas 

 Retrieved file could be transformed by 

document transformation if XML 
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Pattern Benefits/Limitations 

Inbound EIB 

 

 User-driven, bulk data import 

 Single file is imported 

 Single web service is invoked 

 Manual upload 

 External file size < 300 MB 

(attachments < 30 MB; images <1MB) 

Inbound Workday Studio 

 

 Iterate through multiple files 

 Invoke multiple service operations 

 Supports any Public WWS 

 Conditional logic 

 Complex validation and error handling 

 

 

Resource: This guide is a static document; limitations may change between updates. 

Refer to the Workday Administration Guide “Reference: Integrations and Web 

Service Limits” for the most up-to-date integration system resource limits. 
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168 - Reference: Integrations and Web Service Limits 
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ORDER OF CONSIDERATION 
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ACTIVITY 7.1 – DISCUSS INTEGRATION SCENARIOS 

Business Case: Workday supports several integration options that perform similar functions 

but have distinct advantages and limitations. As a group, we will discuss the following 

scenarios to decide which tool(s) is the best for the job. 

 We are not asking you to build these scenarios, just to discuss which technology 

potentially fits best. 

 In some cases, there may be more than one possibility. 

 Do not hesitate to consider “what-if” conditions. E.g., EIB would work if a certain 

assumption were true. 

 

SCENARIO 1 

I need to output a list of active employees that have changes to either their position and/or 

compensation data in the past week. 

SCENARIO 2 

I have an integration that I need to merge the results of a call to get position and job profiles in 

Workday. I need to transform the output into a .csv file and deliver to an SFTP server. This 

integration may process 1 position, or 100 positions, or more. 

SCENARIO 3 

I need to process an incoming a plain text file to update locations in Workday.  

SCENARIO 4 

I need to output a list of active employees. The output will include position and compensation 

data about each employee. The output must be a .csv file that is comma separated with each 

value in double quotes. If there is a value missing in the required Social Security Number field, I 

need an error message to be displayed on the integration event. 

SCENARIO 5 

I need to process an inbound xml file that contains a list of positions. It is mostly formatted 

correctly but needs a couple of changes to the source XML before updating Workday. This 

small file will never contain more than 25 positions at a time. 

SCENARIO 6 

I need to process an XML file that contains time off requests. I need to go through each request 

off and validate the worker’s status, state of residence, and social security number. Once 

validated, I will update Workday. If a worker fails any of the validations, their record will not be 

updated in Workday, but will be written out to a log error file. 
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SCENARIO 7 

I have a small group of Workers that are happy to manually enter a time off request but do not 

have access to Workday. If I can provide them with a template, they can populate it and email 

the file back to me. 

SCENARIO 8 

Our Financials department needs to send us new organizations, updates to existing 

organizations, as well as be able to inactivate organizations. They are internal and are 

agreeable to the format of the file. 

SCENARIO 9 

Run a report to get a list of active employees from a specified supervisory organization hired 

between a set of dates, generate a .csv file and deliver it to secured endpoint. 

SCENARIO 10 

I need to process the Hire Employee process on an inbound xml file. I need to verify the position 

is available for each future employee and that each one has an existing pre-hire ID. If the 

position is not available for hire, I need to generate an error log for that record. If the position is 

available and they do not have an existing pre-hire ID, I need to create the pre-hire record 

before I process the hire. If the position is available and the pre-hire exists, I need to hire in 

Workday. 

SCENARIO 11 

I need to send position information to a system of record. 

What do I need to consider for this outbound integration? 

SCENARIO 12 

I am receiving a file with a list of workers that have personal data updates. 

What do I need to consider for this inbound integration? 
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APPENDIX A – CLASS EVALUATIONS 

CLASS EVALUATION (SESSION WITHIN A CURRICULUM): AVAILABLE AT 

THE START OF THE LAST DAY OF CLASS 

1. Log in to the Learning Center: https://workday.csod.com 

2. Select View Transcript. 

3. Locate the training session within the curriculum in your Active tab. (Use the search field 

to quickly find your training session and select the Curriculum Training Tile link to open 

the curriculum.) 

4. Select Evaluate under the Options column. 

 

 

CLASS EVALUATION (WITHIN A CURRICULUM): AVAILABLE AFTER 

CLASS ENDS AND ROSTER SUBMITTED 

1. Log in to the Learning Center: https://workday.csod.com 

2. Select View Transcript. 

3. Select the Active tab to toggle to your Completed training. 
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Note: If the curriculum is still Active, meaning the curriculum requirements have not been 

met, the curriculum will remain on the Active tab. 

4. Locate and select the completed training curriculum. Select the Training Title link to 

open the curriculum and locate the session. (Use the search field to quickly find your 

training session.) 

5. Click Evaluate. 
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APPENDIX B – WORKDAY PRO 

CUSTOMER ACCREDITATION PROGRAM 

Workday Pro is a customer-focused accreditation program targeted at customers who want to 

actively engage and work side-by-side with the ecosystem on a path to develop a similar level of 

knowledge and expertise. It consists of several tracks, each with relevant courses, plus a written 

test. 

 

Learn more: community.workday.com/pro 
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APPENDIX C: ACTIVITY ANSWER KEY 

INTRODUCTION 

This section contains answers to questions posed throughout the activities in this course. 

 

CHAPTER 2 ANSWERS 

ACTIVITY 2.2 – ADD BUSINESS OBJECTS TO RAAS 

Task #2: Compare Simple XML to Workday XML 

6A. Compare the Simple XML to the Workday XML. What do you notice about the business 

objects? Simple XML only contains object descriptors; no Integration IDs; multiple 

instances are collapsed into a single element; dates don’t include time zone offset. 

6B. Compare the actual URLs of the Workday XML and the Simple XML. What is the 

difference between them? The Simple XML URL includes &format=simplexml. 

6C. What is controlling the element names of the fields in the Workday XML?  For example, 

if you wanted to change the value of <wd:AvailabilitytDt> to <wd:AvailabilityDate>, where 

is that action performed? Report definition – Column Heading Override XML Alias. 

6D. When viewing the Workday XML, the document contains a namespace of 

wd=”urn:com.workday.report/WICT_RW_Positions”. Where in the report definition is that 

defined? Report definition – Advanced tab. 

 

ACTIVITY 2.3 – FIND INTEGRATION IDS 

Task #1: Use the UI to view Reference IDs 

Object Integration ID Type Value 

Organization Organization_Reference_ID Human_Resources_supervisory 

Position WID ae5982654df8420dacc5f530e096215b 

Time Type Position_Time_Type_ID Full_time 

Location Location_ID San_Francisco_site 

Task #2: Use the Integration IDs report to view Integration IDs 

Business 

Object 

Instance Integration ID Type Value 

Language French WID 67327bff5f014925a36d37d2ef380159 

Language Russian Language_ID 234.4 

Country United States WID bc33aa3152ec42d4995f4791a106ed09 
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Business 

Object 

Instance Integration ID Type Value 

Country Canada ISO_3166-1_Alpha-2_Code CA 

Employee 

Type 

Regular WID 9459f5e6f1084433b767c7901ec04416 

Supervisory 

Organization 

IT HelpDesk 

Department 

WID af6d7f10878340d186121b9d88ae1b5d 

Supervisory 

Organization 

Field Sales – 

North 

American 

Group 

Organization_Reference_ID Field_Sales_NA_supervisory 

General 

Event 

Subcategory 

Request 

Compensation 

Change > 

Adjustment > 

Performance 

General_Event_Subcategory_ID Request_Compensation_Change_Adjustment_P

erformance 

Task #3: Use the View Reference IDs report to view Reference IDs 

Business Object Instance Reference ID Type Value 

Absence Plan Floating Holiday Plan Absence_Plan_ID FH_USA 

Compensation Plan General Salary Plan Compensation_Plan_ID SALARY_Salary_Plan 

 

CHAPTER 3 ANSWERS 

DEMO 3.1 – REVIEW SOAP REQUESTS AND RESPONSES USING SOAPUI 

Task #3: Create Request to Get Positions 

7A. How many positions (Total Results) did Workday find based on our request? 570. 

7B. How many total pages of results does this represent? 6. 

7C. How many results were returned to SoapUI based on our request? 100. 

7D. Which page was returned? 1. 

7E. What types of positional data are included in the response? Position Reference, 

Supervisory Organization, Effective Date, Position Definition Data, and Closed. 

Task #4: Modify Request to Retrieve 5 IT HelpDesk Positions, including Qualification 

Data 

6A. How many positions (Total Results) did Workday find based on our request? 8 

6B. How many total pages of results does this represent? 2 
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6C. How many results were returned to SoapUI based on our request? 5 

6D. What is a friendlier alternative to the WID to specify an organization? 

Organization_Reference_ID 

6E. .What Response Groups are now included in the output? Position_Definition_Data 

and Qualification_Data 

6F. Are any Response Groups missing that were in the first response? 

Position_Reference 

 

CHAPTER 4 ANSWERS 

ACTIVITY 4.3 – COMPARE WORKDAY OUTPUT TO XSLT 

Task #1: Compare Report Output to XSLT 

3. Review the XSLT file and compare to the report definition. Find four errors. Incorrect 

namespace, ID element missing closing tag, wd:AvailabilityDt misspelled, 

wd:Restrictions-Type uses a period instead of a colon. 

 

CHAPTER 6 ANSWERS 

ACTIVITY 6.1 – LAUNCH WORKDAY STUDIO INTEGRATION 

Task #1: Review Integration Services Configuration 

4A. What is the value of the Testing Mode attribute? Yes. 

4B. What is the name of the Integration Map? Worker Type. 

What values are being mapped? Contingent Worker (Casual) and Employee (Emp). 

4C. What is the Launch Parameter? Supervisory Organization. Is it Required? Yes. 

6A. How many Integration Sequencers have been configured? 2. 

6B. What are their Format/Syntax values? Positions_Final_[yyyy]-[MM]-[dd]_[seq].xml and 

Positions_Original_[yyyy]-[MM]-[dd]_[seq].xml. 

 

Task #2: Launch a Studio Integration 

4A. What is the Status? Completed With Errors. 
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4B. Are there any Error or Warning messages? 2 Errors. 

4C. Which tab shows the launch parameter value? Integration Details. 

4D. What files were output? Positions_Orig_1-____.xml and Positions_Final_1-____.xml. 

4E. Are any of the files Deliverable? Positions_Final_1-____.xml only. 

5A. How are the files different? Positions_Final has a simpler structure with uppercase tags, 

no namespaces, external mapped Worker Types, and Position ID and Availability values 

as attributes. 

5B. Where do you see the value of the Integration Attribute? As an attribute in the Final file 

only. 

 

CHAPTER 7 ANSWERS 

ACTIVITY 7.1 – DISCUSS INTEGRATION SCENARIOS 

Scenario 1 

I need to output a list of active employees that have changes to either their position and/or 

compensation data in the past week. 

Core Connector: Position is delivered and has built-in change detection. 

Scenario 2 

I have an integration that I need to merge the results of a call to get position and job profiles in 

Workday. I need to transform the output into a .csv file and deliver to an SFTP server. This 

integration may process 1 position, or 100 positions, or more. 

Workday Studio can make multiple web service calls and is the best tool to scale to an unknown 

number of records. 

Scenario 3 

I need to process an incoming a plain text file to update locations in Workday. 

Workday Studio. There is no connector for inbound locations, and document transformation and 

EIB can only process an XML input. 

Scenario 4 

I need to output a list of active employees. The output will include position and compensation 

data about each employee. The output must be a .csv file that is comma separated with each 

value in double quotes. If there is a value missing in the required Social Security Number field, I 

need an error message to be displayed on the integration event. 
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Connector + Document Transformation. Core Connector: Worker can provide the employee 

data (including position and compensation). Document Transformation can easily convert XML 

to the specific CSV format and apply simple validation. 

Workday Studio would only be necessary if you wanted to handle the error. 

Scenario 5 

I need to process an inbound xml file that contains a list of positions. It is mostly formatted 

correctly but needs a couple of changes to the source XML before updating Workday. This 

small file will never contain more than 25 positions at a time. 

Inbound EIB can apply XSLT for transformation and is a good option to import a small volume of 

“trusted” data that does not need additional processing. 

Scenario 6 

I need to process an XML file that contains time off requests. I need to go through each request 

off and validate the worker’s status, state of residence, and social security number. Once 

validated, I will update Workday. If a worker fails any of the validations, their record will not be 

updated in Workday, but will be written out to a log error file. 

Studio is the only Workday option for conditional, branching logic (including file processing) 

based on custom validation. 

Scenario 7 

I have a small group of workers that are happy to enter time off requests manually but do not 

have access to Workday. If I can provide them with a template, they can populate it and email 

the file back to me. 

Inbound EIBs can produce spreadsheet templates that allow users to bulk load data into a web 

service without developing a complicated transformation. 

Scenario 8 

Our Financials department needs to send us new organizations, updates to existing 

organizations, as well as be able to inactivate organizations. They are internal and are 

agreeable to the format of the file. 

The Organization Inbound Connector can perform all of those functions, and supports both a 

CSV and an XML schema. 

An Inbound EIB based on the Add Update Organization operation could perform the same 

function. You would have less support but gain the use of spreadsheet templates. 

Scenario 9 

Run a report to get a list of active employees from a specified supervisory organization hired 

between a set of dates, generate a .csv file and deliver it to secured endpoint. 
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Outbound EIB using RaaS with CSV as the alternate output format is the simplest option to 

deliver the file to a single endpoint. 

Core Connector: Worker could also provide the data if a report was not a requirement. (You 

would need to configure Document Transformation [XTT] and Document Delivery steps in the 

business process.) 

Scenario 10 

I need to process the Hire Employee process on an inbound xml file. I need to verify the position 

is available for each future employee and that each one has an existing pre-hire ID.  If the 

position is not available for hire, I need to generate an error log for that record. If the position is 

available and they do not have an existing pre-hire ID, I need to create the pre-hire record 

before I process the hire. If the position is available and the pre-hire exists, I need to hire in 

Workday. 

Workday Studio could handle the multiple service calls and conditional processing in a single 

assembly. 

However, all of the listed requirements can be handled by an Inbound EIB using a spreadsheet 

template based on the Hire Employee web service operation. This would require that the user 

launch the EIB multiple times with the “Add Errors to Attachment” option. 

Scenario 11 

I need to send position information to a system of record. 

What do I need to consider for this outbound integration? 

Data source and criteria, change detection, data structure and mapping, transport protocol, data 

volume, etc. 

Scenario 12 

I am receiving a file with a list of workers that have personal data updates. 

What do I need to consider for this inbound integration? 

Which Workday web service operation, data structure and mapping, transport protocol, data 

volume, etc. 
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APPENDIX D – ADDITIONAL SOAPUI ACTIVITIES 

IMPORT WWS AND RAAS REQUESTS USING SOAPUI 

The following activities provide more examples of using a third-party application to execute both 

SOAP and REST Workday service requests. 
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ACTIVITY D.1 – IMPORT CURRENCY UPDATES 

USING SOAPUI 

Business Case: We are going to use SoapUI to test the Import Currency Conversion Rates 

web service operation. This operation is in the Financial Management web service. 

 

TASK #1: DETERMINE WWS ENDPOINT 

1. Sign in to your tenant as Logan McNeil (lmcneil). 

2. Search for and run the Public Web Services report. 

3. Review the list of available web services. 

4. Use the Financial Management service’s related actions to select Web Service > View 

WSDL. 

5. In the new browser tab or window that opened, scroll to the bottom of the downloaded 

WSDL document. 

A. Locate the value of the soapbind:address location attribute. 

B. Select and copy (Ctrl-C) the address location (only select the value in quotes). 

 

169 - SOAP binding address location for Financial Management WWS 

6. Close the new browser window or tab. 

 

TASK #2: CREATE WWS TEST PROJECT WITH SOAPUI 

1. Launch SoapUI using its desktop icon  or Start menu shortcut (under SmartBear). 

2. Create a new SoapUI project for your tests by selecting File > New SOAP Project. 

3. Enter the details for your new project: 
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Field Name Entry Value 

Project Name WICT Currency Import 

Initial WSDL [service address location from previous task 

+ “?wsdl” suffix] 

Create Requests Unchecked 

 

170 - SoapUI New SOAP Project 

4. Click OK to retrieve the WSDL into the SoapUI project. 

 

TASK #3: CREATE REQUEST TO IMPORT CURRENCY CONVERSIONS 

1. Right-click on the Import_Currency_Conversion_Rates operation and select New 

Request. 

 

171 - SoapUI New Request command 

2. Enter WICT Import Currency as the name for your new request and click OK. 
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3. Replace the XML with the contents of the 

SoapUI_Import_Currency_Conversion_Rates_Request.txt class file. 

 

172 - Import Currency Conversion Rates request 

4. In the Project Navigator, expand the Import Currency Conversion Rates operation and 

select the WICT Import Currency request. 

5. Enter the following information into the Request Properties sheet: 

Property Value 

Username lmcneil@crossappgmsXX (where XX 

are the digits of your tenant) 

Password [your tenant password] 

WSS-Password Type PasswordText 
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173 - Request Properties 

6. Click the Submit button  to send the request. 

 

174 - Get Positions Response with no criteria 

7. Review the response. 

 

TASK #4: VERIFY IMPORT 

1. Sign in to your tenant as Logan McNeil (lmcneil). 

2. Search for and run the Process Monitor report. 

A. Enter a Process Type of Web Service. 

B. Click the OK button. 
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175 - Process Monitor search criteria 

3. Click the Import Currency Conversion Rates Request link. 

 

176 - Process Monitor results 

4. Review the Messages section to verify that the import process completed with one error.  
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177 - Import Currency Conversion Rates Background Process Messages 

5. Search for and run the Currency Rates as of Date report. 

A. Enter USD in Source Currencies. 

B. Click OK to run the report. 

 

178 - Currency Rates as of Date report prompt 
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6. Sort the report by Currency Rate Timestamp in Descending order and verify that 8 

new rates were imported. 

 

179 - Currency Rates as of Date report with imported results 
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ACTIVITY D.2 – RAAS-BASED REST AND SOAP API 

REQUESTS USING SOAPUI 

Business Case: We are going to use SoapUI to create a REST and SOAP API projects for our 

custom RaaS. 

 

TASK #1: DETERMINE REST ENDPOINT 

1. Sign in to your tenant as Logan McNeil (lmcneil). 

2. Search for the WICT RW Positions report. 

3. In the All of Workday section, use the report’s related actions to select Web Service > 

View URLs. 

4. At the prompt, leave the criteria blank and click OK. 

5. On the View URLs Web Service page, select the WSDL link. 

 

180 - View URLs Web Service page with WSDL link 

A. Locate the value of the httpbind:address location attribute. 

B. Select and copy (Ctrl-C) the address location (only select the value in quotes). 
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181 – REST API httpbind:address location 

NOTE: The WSDL also includes SOAP bind address information, which we will use in a later 

task. Keep the tab open. 

 

TASK #2: CREATE RAAS REST PROJECT WITH SOAPUI 

1. Launch SoapUI using its desktop icon  or Start menu shortcut (under SmartBear). 

2. Create a new SoapUI project for your tests by selecting File > New REST Project. 

A. Enter the httpbind:address location into the URI field 

B. Click OK. 

 

182 - SoapUI New REST Project dialog 
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3. Enter the your tenant Username and Password into the Request Properties sheet: 

 

183 – SoapUI REST Request Properties 

4. Use the Add button  to add the following parameters to the request: 

Name Value 

Start 2000-01-01 

End [Today’s Date] 

Supervisory_Organization!Organization_Reference_ID IT_HelpDesk_supervisory 

 

184 - SoapUI REST Request Parameters 
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5. Click the Submit button  to send the request, and review the response. 

 

185 - SoapUI REST Response 

 

TASK #3: CREATE A RAAS SOAP REQUEST  

1. View the WSDL from Task #1, Step 5. 

A. Locate the value of the soapbind:address location attribute. 

B. Select and copy (Ctrl-C) the address location (only select the value in quotes). 
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186 - SOAP API soapbind:address location 

1. 2. In SoapUI, create a new SoapUI project for your tests by selecting File > New 

SOAP Project. 

2. Enter the details for your new project: 

Field Name Entry Value 

Project Name WICT Positions RaaS 

Initial WSDL [service address location from Step 1 + 

“?wsdl” suffix] 

Create Requests Checked 

 

187 - New SoapUI SOAP Project with Create Requests selected 

3. In the project folder, expand ReportBinding and Execute_Report, and double-click 

Request 1. 
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4. Modify the XML to submit a test request: 

<soapenv:Envelope 

xmlns:soapenv="http://schemas.xmlsoap.org/soap/envelope/" 

xmlns:wict="urn:com.workday.report/WICT_RW_Positions"> 

   <soapenv:Header/> 

   <soapenv:Body> 

      <wict:Execute_Report> 

         <!--Optional:--> 

         <wict:Report_Parameters> 

            <!--Zero or more repetitions:--> 

            <wict:Supervisory_Organization wict:Descriptor="true"> 

               <!--Zero or more repetitions:--> 

               <wict:ID 

wict:type="Organization_Reference_ID">IT_HelpDesk_supervisory</wict:ID> 

            </wict:Supervisory_Organization> 

            <!--Optional:--> 

            <wict:Start>2000-01-01</wict:Start> 

            <!--Optional:--> 

            <wict:End>2018-04-05</wict:End> 

         </wict:Report_Parameters> 

      </wict:Execute_Report> 

   </soapenv:Body> 

</soapenv:Envelope> 

5. With Request 1 still selected in the Project Navigator, enter the following information into 

the Request Properties sheet: 

Property Value 

Username lmcneil@crossappgmsXX (where XX 

are the digits of your tenant) 

Password [your tenant password] 

WSS-Password Type PasswordText 
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188 - SoapUI SOAP Request Properties 

6. Click the Submit button  to send the request and review SOAP response. 

 

189 - SoapUI SOAP Response from RaaS 

 

 


